Notes, cautions, and warnings

NOTE: A NOTE indicates important information that helps you make better use of your product.

CAUTION: A CAUTION indicates either potential damage to hardware or loss of data and tells you how to avoid the problem.

WARNING: A WARNING indicates a potential for property damage, personal injury, or death.
6 Configuring load balancing

Setting up the ARR Proxy Server ................................................................. 71
Installing Internet Information Services—IIS ........................................ 72
Installing the ARR Module ........................................................................ 73
Configuring the Application Pool Process for ARR ................................ 74
Creating a Server Farm of WDM Management Servers ....................... 75
Configuring SSL ......................................................................................... 76
Configuring Server Farm Properties for ARR .......................................... 77
Configuring Request Filtering .................................................................. 78
Setting up Proxy FGDN in WDM Preferences ......................................... 78
Installing WDM Components .................................................................. 79
Configuring Load Balancing for ThreadX 4.x Devices .............................. 79
Configuring load balancing for ThreadX 5.x devices ................................. 80
Installing and configuring HAProxy .......................................................... 87
Installing Teradici Device Proxy Servers .................................................. 89
Adding Teradici Device Proxy Servers to WDM ....................................... 91
Adding HAProxy to WDM ......................................................................... 92
Restarting Threadx API ............................................................................. 93

7 Configuring high availability of web UI service .................................... 96
Setting up the ARR Proxy Server ................................................................. 96
Installing Internet Information Services—IIS ........................................ 97
Installing the ARR module ........................................................................ 98
Changing application pool process model for Application Request Routing ................................................................................ 98
Create a Server Farm of web UI servers .................................................. 99
Configuring SSL on the proxy server ........................................................ 102
Configuring server farm properties for Application Request Routing .... 103
Logging to the web UI browser ................................................................. 104

8 Manual installation of WDM database using scripts ............................ 105
Requirements .......................................................................................... 105
Proposed way of installing WDM database .............................................. 105
Script files ................................................................................................. 105

9 Troubleshooting ..................................................................................... 108
Failure While Attaching the Database ..................................................... 109
Error While Installing WDM Database in a Distributed Setup ................ 109
Database Installation Failure After Manual Uninstallation of SQL Server Express 2014 ................................................................. 109
After Upgrading from WDM 5.5.1 to WDM 5.7 Software Repository is not Secure ................................................................. 109
Troubleshooting Post Deployment .......................................................... 110
Troubleshooting Load Balancing Issues .................................................. 110
Health test feature failure in ARR proxy with SSL ................................ 110
ARR Proxy Returns HTTP Error Code 502.3 ............................................ 110
ARR Proxy Returns HTTP Error Code 502.4 ............................................ 111
Enabling SSL Offloading on Proxy .......................................................... 111
Contents

Indefinite Preceding during Installation................................................................. 111
Load Balancer Issue.......................................................................................... 111
Upgrading WDM on Windows 2008 SP2 32 bit...................................................... 111
WDM Upgrade Installation Fails ........................................................................ 111
Cloud Environment Setup Issue...................................................................... 112
Error in Installation of WDM in Upgrade Setup.............................................. 112
Dell Wyse Device Manager (WDM) is a software that manages all Dell Wyse thin and zero clients. WDM enables IT administrators to perform the following functions:

- Software imaging, updating, and configuring thin and zero client devices
- Asset tracking of devices
- Monitoring the health of devices
- Managing the policies and network settings on devices
- Remotely administering and shadowing the devices

WDM uses industry standard communication protocols and a component-based architecture to efficiently manage the devices on your network. This guide provides information about the prerequisites to install WDM, and the steps to install and configure WDM in your environment.

Topics:

- Installer Matrix
- Support matrix
- Localization Support
- Dell Wyse technical support

**Installer Matrix**

The following matrix describes the various combinations of Microsoft SQL Server, and Microsoft Windows Server that the installer supports.

**Table 1. Installer matrix**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Workgroup</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Distributed</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Enterprise</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Workgroup</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Distributed</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>---------------------------------------</td>
<td>----------------------------</td>
<td>------------------------</td>
<td>---------------------</td>
<td>---------------------------------</td>
</tr>
</tbody>
</table>

Table 2. Support matrix
<table>
<thead>
<tr>
<th>Supported thin clients</th>
<th>Wyse ThinOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Wyse 3010 thin client with ThinOS</td>
<td></td>
</tr>
<tr>
<td>• Wyse 3020 thin client with ThinOS</td>
<td></td>
</tr>
<tr>
<td>• Wyse 3040 thin client with ThinOS</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5010 thin client with ThinOS</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5040 thin client with ThinOS</td>
<td></td>
</tr>
<tr>
<td>• Wyse 3030 LT thin client with ThinOS</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5060 thin client with ThinOS</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7010 thin client with ThinOS</td>
<td></td>
</tr>
<tr>
<td>Wyse ThinOS PCoIP</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5040 AIO thin client with PCoIP</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5010 thin client with PCoIP</td>
<td></td>
</tr>
<tr>
<td>• Wyse 3030 LT thin client with PCoIP</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5060 thin client with PCoIP</td>
<td></td>
</tr>
<tr>
<td>Wyse Enhanced Microsoft Windows Embedded Standard 7—Build 818 and later</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5010 thin client with WES7</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5020 thin client with WES7</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7010 thin client with WES7</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7020 thin client with WES7</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7010 extended chassis thin client with WES7</td>
<td></td>
</tr>
<tr>
<td>• Wyse 3030 thin client with WES7</td>
<td></td>
</tr>
<tr>
<td>Wyse Enhanced Microsoft Windows Embedded Standard 7P—Build 850 and later</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7010 thin client with WES7P</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7010 Extended Chassis thin client with WES7P</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5020 thin client with WES7P</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7020 thin client with WES7P</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7040 thin client with WES7P</td>
<td></td>
</tr>
<tr>
<td>• Dell Latitude E7270 mobile thin client</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5060 thin client with WES7P</td>
<td></td>
</tr>
<tr>
<td>• Dell Latitude 3460 mobile thin client</td>
<td></td>
</tr>
<tr>
<td>Wyse Enhanced Microsoft Windows Embedded 8 Standard—64-bit</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5010 thin client with WE8S</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5020 thin client with WE8S</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7010 thin client with WE8S</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7020 thin client with WE8S</td>
<td></td>
</tr>
<tr>
<td>Windows 10 IoT Enterprise—64-bit</td>
<td></td>
</tr>
<tr>
<td>• Wyse 5020 thin client with Win10 IoT</td>
<td></td>
</tr>
<tr>
<td>• Wyse 7020 thin client with Win10 IoT</td>
<td></td>
</tr>
<tr>
<td>Supported EOL Dell Wyse thin client platforms</td>
<td>Wyse Enhanced Microsoft Windows Embedded Standard 7—Build 818 and later</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Wyse 7040 thin client with Win10 IoT</td>
<td>C90LE7</td>
</tr>
<tr>
<td><strong>Wyse Enhanced SUSE Linux Enterprise</strong></td>
<td>R90L7</td>
</tr>
<tr>
<td>• Wyse 5010 thin client with Linux</td>
<td>R90LE7</td>
</tr>
<tr>
<td>• Wyse 5020 thin client with Linux</td>
<td>X90c7</td>
</tr>
<tr>
<td>• Wyse 7010 thin client with Linux</td>
<td>X90m7</td>
</tr>
<tr>
<td>• Wyse 7020 thin client with Linux</td>
<td>Z90s7</td>
</tr>
<tr>
<td><strong>ThinOS Lite</strong></td>
<td><strong>Wyse Enhanced Microsoft Windows Embedded Standard 7P</strong></td>
</tr>
<tr>
<td>• Wyse 3010 zero client for Citrix</td>
<td>X90m7P</td>
</tr>
<tr>
<td>• Wyse 3020 zero client for Citrix</td>
<td>Z90s7P</td>
</tr>
<tr>
<td>• Wyse 5010 zero client for Citrix</td>
<td><strong>Wyse Enhanced Microsoft Windows Embedded 8 Standard—32-bit</strong></td>
</tr>
<tr>
<td><strong>ThreadX/View zero client</strong></td>
<td>• Wyse 5030 zero client</td>
</tr>
<tr>
<td>• Wyse 5050 AIO zero client with PCoIP</td>
<td>• Wyse 7030 zero client</td>
</tr>
<tr>
<td>• Wyse 5050 AIO zero client with PCoIP</td>
<td>• Wyse 5050 AIO zero client with PCoIP</td>
</tr>
<tr>
<td><strong>ThinLinux</strong></td>
<td>• Wyse 3030 LT thin client with ThinLinux</td>
</tr>
<tr>
<td>• Wyse 3030 LT thin client with ThinLinux</td>
<td>• Wyse 3040 thin client with ThinLinux</td>
</tr>
<tr>
<td>• Wyse 7020 thin client with ThinLinux</td>
<td>• Wyse 7020 thin client with ThinLinux</td>
</tr>
<tr>
<td>• Wyse 5020 thin client with ThinLinux</td>
<td>• Wyse 5020 thin client with ThinLinux</td>
</tr>
<tr>
<td>• Wyse 5060 thin client with ThinLinux</td>
<td><strong>Wyse Enhanced SUSE Linux Enterprise</strong></td>
</tr>
<tr>
<td><strong>Supported EOL Dell Wyse thin client platforms</strong></td>
<td>• C50LE</td>
</tr>
<tr>
<td><strong>Wyse Enhanced Microsoft Windows Embedded Standard 7—Build 818 and later</strong></td>
<td>• R50L</td>
</tr>
<tr>
<td>• Wyse Enhanced SUSE Linux Enterprise**</td>
<td>• R50LE</td>
</tr>
<tr>
<td>• Wyse 5010 thin client with Linux</td>
<td>• X50c</td>
</tr>
<tr>
<td>• Wyse 5020 thin client with Linux</td>
<td>• X50M</td>
</tr>
<tr>
<td>• Wyse 7010 thin client with Linux</td>
<td>• Z90D8E</td>
</tr>
<tr>
<td>ThinOS Lite</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td></td>
</tr>
<tr>
<td>Z50S</td>
<td></td>
</tr>
<tr>
<td>C00X</td>
<td></td>
</tr>
<tr>
<td>R00X</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ThreadX/View zero client</th>
</tr>
</thead>
<tbody>
<tr>
<td>P20</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wyse ThinOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>C10LE</td>
</tr>
<tr>
<td>R10L</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wyse Enhanced Microsoft Windows Embedded Standard 2009 —Build 641 and later</th>
</tr>
</thead>
<tbody>
<tr>
<td>C90LEW</td>
</tr>
<tr>
<td>5010</td>
</tr>
<tr>
<td>R90LW</td>
</tr>
<tr>
<td>R90LEW</td>
</tr>
<tr>
<td>V90LEW</td>
</tr>
<tr>
<td>X90CW</td>
</tr>
<tr>
<td>X90MW</td>
</tr>
<tr>
<td>7010</td>
</tr>
<tr>
<td>Z90SW</td>
</tr>
</tbody>
</table>

### Localization Support

For the WDM Server, localization support is provided on Windows 2008 R2 SP1 Enterprise Edition, Windows 2012 Standard R2, and Windows 2016 Standard R2 for the following languages:

- French
- German
- Spanish
- Japanese
- Simplified Chinese

### Dell Wyse technical support


Related documentation and services

Fact sheets containing features of hardware products are available on the Dell Wyse website. Go to http://www.dell.com/wyse and select your hardware product to locate and download the Fact Sheet.

To get support for your Wyse product, check your product Service Tag or serial number.

- For Dell service tagged products, find knowledge base articles and drivers on the Dell Wyse product pages.
- For Non-Dell Service Tagged Products, find all the support needed by accessing the Wyse support domain.

Dell Wyse online community

Dell Wyse maintains an online community where users of our products can seek and exchange information about user forums. Visit the Dell Wyse online community forums at: en.community.dell.com/techcenter/enterprise-client/wyse_general_forum/.
This section lists the prerequisites, the hardware, and software requirements that you must complete to prepare your environment to install and configure WDM. This section consists of:

- Pre-installation checklist
- Hardware requirements
- Software requirements
- Communication port requirements
- Upgrade requirements
- Requirements for managing PCoIP devices

Topics:
- Pre-installation Checklist
- Hardware Requirements
- Communication port requirements
- Requirements for managing PCoIP devices
- Checklist to install WDM Enterprise edition

Pre-installation Checklist

Before you begin installing WDM, ensure that you meet the following requirements:

- The server on which you install WDM should be dedicated to WDM services and should not be performing additional functions. For example, the server should not be functioning as a Domain Controller, Backup Controller, Mail Server, Production Web Server, DHCP Server, MSMQ Server, or Application Server.
- Install a supported operating system on the server on which you install WDM. For more information, see Support Information.
- Ensure that no other applications that require IIS are running on the system on which you are installing WDM.
- Ensure that all required communication ports are available and open for communication between servers, routers, and switches. For more information, see Communication Port Requirements.
- Ensure that you have access to your operating system CD-ROM and your Microsoft Windows system files during your installation. The WDM installer checks the system for all the software requirements. If any software is not installed, the installer prompts you to install the required software. Therefore, you must have access to your operating system CD-ROM or the network location to access the Microsoft Windows system files.
- Install Adobe Acrobat reader to read the End User License Agreement (EULA) and the Installation Guide.
- The server must be installed with ThreadX 5x components in Windows 2012 and above.
Hardware Requirements

The system on which you install WDM should meet or exceed the minimum system requirements and depends on the operating system you install. The actual free space required depends on the number and size of the packages you register, and also on the number of devices you will be managing.

Table 3. Server Hardware Requirements for 32–bit OS

<table>
<thead>
<tr>
<th>Category</th>
<th>Minimum Requirements</th>
<th>Recommended Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2.5 GHz Dual core Intel or AMD</td>
<td>Quad Core Intel or AMD</td>
</tr>
<tr>
<td>RAM</td>
<td>4 GB</td>
<td>4 GB</td>
</tr>
<tr>
<td></td>
<td>In case of a Virtual Machine, it should be 2 GB initially allocated</td>
<td></td>
</tr>
<tr>
<td>Minimum Free Space</td>
<td>40 GB</td>
<td>40 GB</td>
</tr>
</tbody>
</table>

Table 4. Server Hardware Requirements for 64–bit OS

<table>
<thead>
<tr>
<th>Category</th>
<th>Minimum Requirements</th>
<th>Recommended Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2.5 GHz Dual core Intel or AMD</td>
<td>Quad Core Intel or AMD</td>
</tr>
<tr>
<td>RAM</td>
<td>6 GB</td>
<td>8 GB</td>
</tr>
<tr>
<td>Minimum Free Space</td>
<td>40 GB</td>
<td>40 GB</td>
</tr>
</tbody>
</table>

Communication port requirements

WDM software components require certain communication ports to remain open on your servers, routers, and switches. For example, WDM depends on the HTTP/HTTPS communications ports for operations initiated by WDM and pushed to devices.

Push operations include:

- Issuing quick device commands such as Refresh Device Information, Reboot, Change Device or Network Information, Get Device Configuration, and so on.
- Distributing packages at a specific time.

Typically, port 80 is the default HTTP port and port 443 is the default HTTPS port. If either of these ports are closed, WDM cannot push updates or quick commands to devices.

Table 5. Communication Ports

<table>
<thead>
<tr>
<th>WDM Component</th>
<th>Protocol and Corresponding Ports</th>
<th>Port</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>GUI</td>
<td>HTTP</td>
<td>80</td>
<td>280</td>
</tr>
<tr>
<td></td>
<td>FTP</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OLE DB</td>
<td>1433 (default)</td>
<td>Can be configured during installation.</td>
</tr>
<tr>
<td>WDM Component</td>
<td>Protocol and Corresponding Ports</td>
<td>Port</td>
<td>Function</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------</td>
<td>------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VNC</td>
<td></td>
<td>5800</td>
<td>Remote shadows devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5900</td>
<td></td>
</tr>
<tr>
<td>Web Service</td>
<td>HTTP</td>
<td>80</td>
<td>Communicates with the Web Agent, GUI, and Standard Service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>280</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HTTPS</td>
<td>443</td>
<td>Secure Communication with the Web Agent, GUI, and Standard Service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8443</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OLE DB</td>
<td>1433</td>
<td>Communicate with the WDM Database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(default)</td>
<td>Can be configured during installation</td>
</tr>
<tr>
<td>Web Agent</td>
<td>HTTP</td>
<td>80</td>
<td>Communication with the Web Service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>280</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FTP</td>
<td>21</td>
<td>Read and write files to the master and remote software repositories.</td>
</tr>
<tr>
<td>DHCP Proxy and TFTP Services</td>
<td>OLE DB</td>
<td>1433</td>
<td>Communicate with the WDM database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(default)</td>
<td>Can be configured during installation</td>
</tr>
<tr>
<td></td>
<td>HTTP</td>
<td>8008</td>
<td></td>
</tr>
<tr>
<td>DHCP Proxy and TFTP Services and PXE</td>
<td>DHCP</td>
<td>67</td>
<td>Process UDP requests from PXE-enabled devices to the Standard Service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>68</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4011</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TFTP</td>
<td>69</td>
<td>Download bootable image to enable management processing.</td>
</tr>
<tr>
<td></td>
<td>HTTP</td>
<td>80</td>
<td>Communicate with the Web Service regarding actions and status of current task.</td>
</tr>
<tr>
<td></td>
<td>FTP</td>
<td>21</td>
<td>Download and upload files to the master and remote software repositories.</td>
</tr>
<tr>
<td>DHCP Proxy and TFTP Services and legacy support for older WDM agents</td>
<td>UDP</td>
<td>44956</td>
<td>Discover devices using subnet directed broadcasts that have older WDM Agents (5.0.0.x and earlier) installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>44957</td>
<td></td>
</tr>
<tr>
<td>ThreadX 4.x Manager Service</td>
<td>TCP</td>
<td>44955</td>
<td>Discover devices using IP Range Walking. Upgrade devices that have an older WDM Agent (5.0.0.x and earlier) installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9880</td>
<td>Communicate with ThreadX 4.x devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50000</td>
<td></td>
</tr>
</tbody>
</table>
### Requirements for managing PCoIP devices

PCoIP devices that run the ThreadX firmware require a DNS Service Location (SRV) resource record to perform the following actions:

- **Partial Check-In (heartbeat)**—The device performs a heartbeat check-in every hour.
- **Firmware Download Completion Status**—The firmware upload is initiated by the server and the download completion is initiated by the device using the DNS SRV record.
- **ThreadX 4.x**—Configure FTP if you intend to use the firmware upgrade feature for PCoIP (ThreadX 4.x) devices. You must enable this in the Software Repository. For more information on enabling FTP in the Software Repository, see the *Dell Wyse Device Manager Administrator’s Guide*.
- **ThreadX 5.x**—Configure CIFS if you intend to use the firmware upgrade feature for PCoIP (ThreadX 5.x) devices. You must enable this in the Software Repository. For more information on enabling CIFS in the Software Repository, see the *Dell Wyse Device Manager Administrator’s Guide*.

### Checklist to install WDM Enterprise edition

If you are installing WDM Enterprise edition, then ensure the following:

- Obtain and have access to your WDM Enterprise Sales Key or Enterprise Evaluation Key that you use during installation.
- Install the supported version of SQL Server. The WDM installer provides Microsoft SQL Express 2014 as the default option, but you can choose another supported version of SQL Server.
- You must install FTP services and it should be active to use FTP for Dell Wyse PCoIP (ThreadX 4.x) devices.
- You must install CIFS services and it should be active to use CIFS for Dell Wyse PCoIP (ThreadX 5.x) devices.

**NOTE:**
If you plan to use PCoIP (Thread X), create and configure a DNS Service Location (SRV) resource record. For more information, see [Configuring Load Balancing for ThreadX 4.x Devices](#) and [Configuring Load Balancing for ThreadX 5.x Devices](#).
Installing Wyse Device Manager

WDM consists of the following components:

- Database
- Management Server
- Software Repository
- Other Services
- Web UI

You can install all the components on the same system or you can have a distributed setup where each component is installed on different systems.

WDM is available in the following editions:

- **Enterprise Edition**—This edition needs a specific license key and comes packaged with all the features of WDM. You can manage a very large number of thin client devices using this edition. You can install this edition in a distributed environment and can install every component on different systems.

- **Workgroup Edition**—This edition consists of a free license key and certain features of WDM are disabled. You can manage up to 10,000 thin client devices using this edition. You must install all the components in the same system and you cannot have a distributed setup with this edition.

**NOTE:** Workgroup license needs to be activated.

**NOTE:**

- To run the WDM Installer (Setup.exe), you must log in to the system as an administrator.
- You cannot install WDM on servers running other services such as the DNS, DHCP, AD Domain Services or services that conflict with the WDM functionality and resources.
- When you are installing the WDM database in a standalone or a distributed setup, and want to use an existing SQL database, ensure that it is a full version of SQL Server and not SQL Server Express.
- The Dell Community Forums support the WDM workgroup edition.
- Threadx 5x management component is supported only in enterprise edition.

Topics:

- Installing the WDM Workgroup edition
- Installing the WDM Enterprise edition
- Installing WDM on a cloud environment
- Installing WDM in a Distributed Setup
- Upgrading WDM

Installing the WDM Workgroup edition

**Steps**

1. Extract the contents of the WDM installer on the system where you want to install WDM.
2. Navigate to the folder where you have extracted the installer, and run `Setup.exe`.
The **Welcome** screen is displayed.

![Welcome screen](image)

**Figure 1. Welcome screen**

3. Click **NEXT**.
4. In license type, select **WORKGROUP**, and click **NEXT**.
Figure 2. Workgroup license type

NOTE: For the workgroup edition, the license key is provided within the installer and you need not enter any details.

The Components screen is displayed.
5 Click NEXT.

**NOTE:** All the components are selected by default and you cannot de-select any component.

The **Configure Database** screen is displayed.
On the **Configure Database** screen, select one of the following options:

- **Install New Database Server (Microsoft SQL Express 2016 SP1)** — Select this option if you do not have any supported version of Microsoft SQL Server installed on the system and proceed to step 8.

- **Use Existing Database Server (SQL Server Express or full)** — Select this option if you have already installed a supported version of Microsoft SQL Server on the system. If you select this option, ensure that the existing database server is on the same system where you are installing WDM Workgroup edition, and proceed to step 9.

7 If you have selected the first option in step 7, select the authentication method.

---

**Figure 4. Configure Database screen**

6 On the **Configure Database** screen, select one of the following options:

- **Install New Database Server (Microsoft SQL Express 2016 SP1)** — Select this option if you do not have any supported version of Microsoft SQL Server installed on the system and proceed to step 8.

- **Use Existing Database Server (SQL Server Express or full)** — Select this option if you have already installed a supported version of Microsoft SQL Server on the system. If you select this option, ensure that the existing database server is on the same system where you are installing WDM Workgroup edition, and proceed to step 9.
Figure 5. Install New Database Server option

- **SQL Server Authentication**—This option is selected by default. To configure SQL server authentication, do the following:
  1. Enter the WDM database credentials.
  2. Enter the new database credentials. You can enter the instance name and the database name under the new database server details. The default instance name and database name is displayed as RapportDB.

- **Windows Authentication**—Enter the new database server details. The default instance name and database name is displayed as RapportDB.

**NOTE:**
- Select **Windows Authentication** if you want to connect to the WDM database using your Windows login credentials.
- Password must match complexity rules of the Windows operating system.

If you have selected the second option in step 7, select the authentication method.
Figure 6. Use Existing Database Server option

- **SQL Server Authentication**—This option is selected by default. To configure SQL server authentication, do the following:
  1. Select either the create new user option or Use the existing user option, and then enter the WDM database credentials.
  2. Enter the existing database server details such as server hostname, instance name, database name, port number, SQL administrator name and password. The default port number is 1433.

- **Windows Authentication**—Enter the existing database server details such as server hostname, instance name, database name, port number, SQL administrator name and password.

9 Click NEXT.

The **Configure Software Repository Server** screen is displayed.
On the **Configure Software Repository Server** screen, you can choose one of the following options:

- **CONFIGURE NEW REPOSITORY SERVER** — Select this option if you want the installer to configure a new repository server. To configure a new repository server:
  - Select the protocol and settings to distribute software to the managed devices. **HTTPS** is selected by default. You can also select **FTP** for ThreadX 4.x and **CIFS** for ThreadX 5.x.
  - Select the authentication type. **Windows** is selected by default.

  | NOTE: Basic authentication is required for Linux.
  - Create new user credentials or use an existing user credentials.

- **USE EXISTING REPOSITORY SERVER** — Select this option if you want the installer use an existing repository server. To configure the existing repository server:
  - Select the protocol and settings to distribute software to the managed devices. **HTTPS** is selected by default. You can also select **FTP** for ThreadX 4.x and **CIFS** for ThreadX 5.x.
  - Select the authentication type. **Windows** is selected by default.
  - Enter the server credentials. The server IP address option is grayed out and the default username is rapport.

11 Click **NEXT**.
12 Select the services you want to install, and click **NEXT**.
NOTE: DHCP Proxy is selected by default.

13 Enter the installation path, and click **NEXT**.
Figure 9. Destination screen

14 Select and import the certificate to start the installation.
NOTE: If you click NEXT without selecting a certificate, the installer installs a self signed certificate. Although communication will be encrypted, the system will still not be completely secure. The certificate must be in the format of .pfx file.

The installation progress is displayed on the screen. After the installation is complete, you are prompted to restart your system.
Restart the system for the changes to take effect.

Next step
After installation, ensure that the following checklists are met:

- WDM is installed in `<drive C>\inetpub\ftproot path` and the Rapport folder is created.
- WyseDeviceManager 5.7.3 WebUI icon is created on the desktop.
- In IIS, HApi Application is created under Rapport HTTP server folder.
- In IIS, MyWDM Application is created under Rapport HTTP server folder.
- In IIS, WebUI Application is created under Rapport HTTP server folder.

**NOTE:** After installation, ensure that the database is created with the provided instance and database name.

**Installing the WDM Enterprise edition**

1. Extract the contents of the WDM installer on the system where you want to install WDM.
2. Navigate to the folder where you have extracted the installer, and run `Setup.exe`.
   - If the server does not have .Net framework, then the .Net framework is installed automatically.

   The **Welcome** screen is displayed.
3 Click NEXT.

4 In the license type, select ENTERPRISE.
Figure 13. Enterprise license type

a If you have the WDM license key, select the **I have WDM Enterprise License Key** option, and enter the license key in the space provided.

b If you do not have the license key, select the **30–days Enterprise Evaluation** option.

The license key is entered by default. However, after the 30 days evaluation period, you must obtain the license key and add it to WDM. For more information on adding the license key, see the *Dell Wyse Device Manager Administrator’s Guide*.

5 Click **NEXT**.

6 Select the components you want to install and click **NEXT**.
You can install all the components on the same system or each component on a different system.

NOTE: If you are installing the components separately on different systems, make sure you install the Database first. If you do not install the database, you cannot install the remaining components.

On the Configure Database screen, select one of the following options:
If you have selected the first option in step 7, select the authentication method.
Figure 16. Install New Database Server option

- **SQL Server Authentication**—This option is selected by default. To configure SQL server authentication, do the following:
  1. Enter the WDM database credentials.
  2. Enter the new database credentials. You can enter the instance name and the database name under the new database server details. The default instance name and database name is displayed as RapportDB.

  **NOTE:** Even if you choose Windows Authentication, the WDM installation requires the SQL authentication to access the SQL database. In a standalone installation, after you complete the WDM database installation, the WDM installer takes care of assigning the active directory user to the database and the same user is used for installing the WDM services.

- **Windows Authentication**—Enter the new database server details. The default instance name and database name is displayed as RapportDB.

  **NOTE:**
  - Select **Windows Authentication** if you want to connect to the WDM database using your Windows login credentials.
  - Password must match complexity rules of the Windows operating system.

  If you have selected the second option in step 7, select the authentication method.
**Figure 17. Use Existing Database Server option**

- **SQL Server Authentication**—This option is selected by default. To configure SQL server authentication, do the following:
  1. Select either the create new user option or Use the existing user option, and then enter the WDM database credentials.
  2. Enter the existing database server details such as server hostname, instance name, database name, port number, SQL administrator name and password.

- **Windows Authentication**—Enter the existing database server details such as server hostname, instance name, database name, port number, SQL administrator name and password.

**NOTE:** The default port number is 1433. Dell recommends that you manually enter the port number since it is dynamic. The dynamic port range for TCP/UDP is 49152 to 65535.

10. Click NEXT.

The **Configure Software Repository Server** screen is displayed.
On the Configure Software Repository Server screen, you can choose one of the following options:

- **CONFIGURE NEW REPOSITORY SERVER**—Select this option if you want the installer to configure a new repository server. To configure a new repository server:
  - Select the protocol and settings to distribute software to the managed devices. **HTTPS** is selected by default. You can also select **FTP** for ThreadX 4.x and **CIFS** for ThreadX 5.x.
  - Select the authentication type. **Windows** is selected by default.

  **NOTE:** Basic authentication is required for Linux.

  - Create new user credentials or use an existing user credentials.
Figure 19. CONFIGURE NEW REPOSITORY SERVER option

- USE EXISTING REPOSITORY SERVER—Select this option if you want the installer use an existing repository server. To configure the existing repository server:
  - Select the protocol and settings to distribute software to the managed devices. HTTPS is selected by default. You can also select FTP for ThreadX 4.x and CIFS for ThreadX 5.x.
  - Select the authentication type. Windows is selected by default.
  - Enter the server credentials. The server IP address option is grayed out and the default username is rapport.

![Configure Software Repository Server interface](image)
Figure 20. USE EXISTING REPOSITORY SERVER option

12 Click NEXT.

13 Select the services you want to install, and click NEXT.
Figure 21. Other Services screen

**NOTE:** DHCP Proxy is selected by default.

14 Enter the installation path, and click **NEXT**.
Select and import the certificate to start the installation.

Figure 22. Destination screen
Figure 23. Certificate screen

**NOTE:** If you click the NEXT without selecting a certificate, the installer installs a self signed certificate. The communications are encrypted, but the system is not completely secure. The certificate must be in the format of .pfx file.

The installation progress is displayed on the screen. After the installation is complete, you are prompted to restart your system.
16  Restart the system for the changes to take effect.

Installing WDM on a cloud environment

About this task
To install the WDM on a cloud environment, you must install the enterprise edition.

Steps
1  Extract the contents of the WDM installer on the system where you want to install WDM.

2  Navigate to the folder where you have extracted the installer, and run Setup.exe.

   If the server does not have .Net framework, then the .Net framework is installed automatically.

   The Welcome screen is displayed.
Figure 25. Welcome screen

3. Click **NEXT**.

4. In the license type, select **ENTERPRISE**.
If you have the WDM license key, select the **I have WDM Enterprise License Key** option, and enter the license key in the space provided.

If you do not have the license key, select the **30–days Enterprise Evaluation** option.

The license key is entered by default. However, after the 30 days evaluation period, you must obtain the license key and add it to WDM. For more information on adding the license key, see the *Dell Wyse Device Manager Administrator’s Guide*.

5. Click **NEXT**.

6. Select the components you want to install and click **NEXT**.
You can install all the components on the same system or each component on a different system.

**NOTE:** If you are installing the components separately on different systems, make sure you install the Database first. If you do not install the database, you cannot install the remaining components.

On the **Configure Database** screen, select one of the following options:
8 If you have selected the first option in step 7, select the authentication method.
**Figure 29. Install New Database Server option**

- **SQL Server Authentication**—This option is selected by default. To configure SQL server authentication, do the following:
  1. Enter the WDM database credentials.
  2. Enter the new database credentials. You can enter the instance name and the database name under the new database server details. The default instance name and database name is displayed as RapportDB.

**NOTE:** Even if you choose Windows Authentication, the WDM installation requires the SQL authentication to access the SQL database. In a standalone installation, after you complete the WDM database installation, the WDM installer takes care of assigning the active directory user to the database and the same user is used for installing the WDM services.

- **Windows Authentication**—Enter the new database server details. The default instance name and database name is displayed as RapportDB.

**NOTE:**
- Select **Windows Authentication** if you want to connect to the WDM database using your Windows login credentials.
- Password must match complexity rules of the Windows operating system.

**If you have selected the second option in step 7, select the authentication method.**
Figure 30. UseExisting Database Server option

- **SQL Server Authentication**—This option is selected by default. To configure SQL server authentication, do the following:
  1. Select either the create new user option or Use the existing user option, and then enter the WDM database credentials.
  2. Enter the existing database server details such as server hostname, instance name, database name, port number, SQL administrator name and password.

- **Windows Authentication**—Enter the existing database server details such as server hostname, instance name, database name, port number, SQL administrator name and password.

**NOTE:** The default port number is 1433. Dell recommends that you manually enter the port number since it is dynamic. The dynamic port range for TCP/UDP is 49152 to 65535.

10. Click NEXT.

The **Configure Software Repository Server** screen is displayed.
On the **Configure Software Repository Server** screen, you can choose one of the following options:

- **CONFIGURE NEW REPOSITORY SERVER**—Select this option if you want the installer to configure a new repository server. To configure a new repository server:
  - Select the protocol and settings to distribute software to the managed devices. **HTTPS** is selected by default. You can also select **FTP** for ThreadX 4.x and **CIFS** for ThreadX 5.x.
  - Select the authentication type. **Windows** is selected by default.

  **NOTE:** Basic authentication is required for Linux.

  - Create new user credentials or use an existing user credentials.
Figure 32. CONFIGURE NEW REPOSITORY SERVER option

- **USE EXISTING REPOSITORY SERVER**—Select this option if you want the installer use an existing repository server. To configure the existing repository server:
  - Select the protocol and settings to distribute software to the managed devices. **HTTPS** is selected by default. You can also select **FTP** for ThreadX 4.x and **CIFS** for ThreadX 5.x.
  - Select the authentication type. **Windows** is selected by default.
  - Enter the server credentials. The server IP address option is grayed out and the default username is **rapport**.
Figure 33. USE EXISTING REPOSITORY SERVER option

12 Click NEXT.

13 Select the services you want to install, and click NEXT.
14 Enter the installation path, and click NEXT.
Select and import the certificate to start the installation.

**Figure 35. Destination screen**
NOTE: If you click the NEXT without selecting a certificate, the installer installs a self signed certificate. Although communication will be encrypted, the system will still not be completely secure. The certificate must be in the format of .pfx file.

The installation progress is displayed on the screen. After the installation is complete, you are prompted to restart your system.
16 Restart the system for the changes to take effect.

**Installing WDM in a Distributed Setup**

You can split the WDM components and install them on different systems. This setup is called a distributed setup of WDM. Ideally you can split the components as follows:

- WDM Database
- WDM Management Server, WDM Management Console, and Other Services
- WDM Software Repository
- Web UI

You can also have multiple instances of WDM Management Server and Other Services installed on different systems to enable load balancing. For more information, see Configuring the Load Balancing Feature.

Installing WDM in a distributed setup is most suitable in a large enterprise where you are managing a large number of devices. This section describes in detail the following:

- Installing the WDM Database.
- Installing Management Server and Web UI.
- Installing the Software Repository.
Installing WDM Database

Prerequisite
Before you install the WDM database on a system or virtual machine (VM), ensure that you have installed the supported version of Microsoft SQL Server. If you do not have SQL Server on the system, you can choose to install Microsoft SQL Express 2016 SP1 which is packaged with the WDM installer.

1 | NOTE:
If you are installing the WDM database on an existing SQL Server database, ensure that port 1433 is available on the system.

To install the WDM database, you must select Database on the Components screen, and then continue with the installation process.

Steps
1 Extract the contents of the WDM installer on the system where you want to install WDM.
2 Navigate to the folder where you have extracted the installer and run Setup.exe.
   If the server does not have .Net framework, then the .Net framework is installed automatically.
   The Welcome screen is displayed.
3 Click NEXT.
4 In license type, select ENTERPRISE.
   a If you have the WDM license key, select the I have WDM Enterprise License Key option and enter the license key in the space provided.
   b If you do not have the License key, select the 30–days Enterprise Evaluation option.
      The license key is entered by default. However, after the 30 days evaluation period, you must obtain the license key and add it to WDM. For more information about adding the license key, see the Dell Wyse Device Manager Administrator’s Guide.
5 Click NEXT.
6 Select Database component.
7 On the Configure Database screen, select one of the following options:
   - **Install New Database Server (Microsoft SQL Express 2016 SP1)**—Select this option if you do not have any supported version of Microsoft SQL Server installed on the system and proceed to step 8.
   - **Use Existing Database Server (SQL Server Express or full)**—Select this option if you have already installed a supported version of Microsoft SQL Server on the system. If you select this option, ensure that the existing database server is on the same system where you are installing WDM Workgroup edition, and proceed to step 9.
8 If you have selected the first option in step 7, select the authentication method.
   - **SQL Server Authentication**—This option is selected by default. To configure SQL server authentication, do the following:
      1 Enter the WDM database credentials.
      2 Enter the new database credentials. You can enter the instance name and the database name under the new database server details. The default instance name and database name is displayed as RapportDB.
      1 | NOTE: Even if you choose Windows Authentication, the WDM installation requires the SQL authentication to access the SQL database. In a standalone installation, after you complete the WDM database installation, the WDM installer takes care of assigning the active directory user to the database and the same user is used for installing the WDM services.
   - **Windows Authentication**—Enter the new database server details. The default instance name and database name is displayed as RapportDB.
      1 | NOTE: Select Windows Authentication if you want to connect to the WDM database using your Windows login credentials.
      – Password must match complexity rules of the Windows operating system.
9 If you have selected the second option in step 7, select the authentication method.
   - **SQL Server Authentication**—This option is selected by default. To configure SQL server authentication, do the following:
      1 Select either the Create New User option or Use the existing user option, and then enter the WDM database credentials.
      2 Enter the existing database server details such as server hostname, instance name, database name, port number, SQL administrator name, and password.
• **Windows Authentication**—Enter the existing database server details such as server hostname, instance name, database name, port number, SQL administrator name, and password.

**NOTE:** The default port number is 1433. Dell recommends that you manually enter the port number since it is dynamic. You can add five-digit custom port for TCP/UDP in the range of 49152-65535.

10 Click **NEXT**.
11 Enter the installation path, and click **NEXT**.

The **Installation Summary** screen is displayed.

12 Click **NEXT**.

The installation progress is displayed on the screen. After the installation is complete, you are prompted to restart your system.

13 Restart the system for the changes to take effect.

For manual installation of WDM Database using scripts, see Manual installation of WDM database using scripts.

### Installing management services

**About this task**

You can install the management server, management console, and web user interface on the same system or on different systems.

**Steps**

1. Extract the contents of the WDM installer on the system where you want to install WDM.
2. Navigate to the folder where you have extracted the installer and run **Setup.exe**.
   - If the server does not have .Net framework, then the .Net framework is installed automatically.

   The **Welcome** screen is displayed.

3. Click **NEXT**.
4. In license type, select **ENTERPRISE**.
   
   a. If you have the WDM license key, select the **I have WDM Enterprise License Key** option and enter the license key in the space provided.
   b. If you do not have the license key, select the **30–days Enterprise Evaluation** option.

   The license key is entered by default. However, after the 30 days evaluation period, you must obtain the license key and add it to WDM. For more information about adding the license key, see the *Dell Wyse Device Manager Administrator’s Guide*.

5. Click **NEXT**.
6. Select **Management Server**, **Other Services**, **Management Console**, and **Web UI**.

   **NOTE:** If you are installing each component on a separate system, you can select them one by one following the steps 1 to 5.

7. On the **Configure Database** screen, select one of the following options:
   - **SQL Server Authentication**—This option is selected by default. To configure SQL server authentication, enter the WDM database server credentials.
   - **Windows Authentication**—Enter the WDM database server details such as server name, instance name, database name, password and port number. The **Username** field is grayed out.

   **NOTE:**
   - The default port number is 1433. Dell recommends that you manually enter the port number since it is dynamic. You can add five-digit custom port for TCP/UDP in the range of 49152-65535.
   - Select **Windows Authentication** if you want to connect to the WDM database using your Windows login credentials.

8. Click **NEXT**.
9. Select the services you want to install, and click **NEXT**.

   **NOTE:** **DHCP Proxy** is selected by default.

10 Enter the installation path, and click **NEXT**.
11 Select and import the certificate to start the installation.
NOTE: If you click the NEXT without selecting a certificate, the installer installs a self signed certificate. The communications are encrypted, but the system is not secure. The certificate must be in the format of .pfx file.

The installation progress is displayed on the screen. After the installation is complete, you are prompted to restart your system.

12 Restart the system for the changes to take effect.

NOTE: In distributed environment, Web UI can be installed on a multiple console.

Installing the Software Repository

Prerequisite
The Software Repository is another important component of WDM. The packages to be deployed on the client systems are saved and stored in the software repository. Before you install the Software Repository, ensure that you have installed and configured the WDM database.

Steps
1. Extract the contents of the WDM installer on the system where you want to install WDM.
2. Navigate to the folder where you have extracted the installer and run Setup.exe.
   If the server does not have .Net framework, then the .Net framework is installed automatically.

   The Welcome screen is displayed.
3. Click NEXT.
4. In license type, select ENTERPRISE.
   a. If you have the WDM license key, select the I have WDM Enterprise License Key option and enter the license key in the space provided.
   b. If you do not have the License key, select the 30-days Enterprise Evaluation option.
      The license key is entered by default. However, after the 30 days evaluation period, you must obtain the license key and add it to WDM. For more information about adding the license key, see the Dell Wyse Device Manager Administrator’s Guide.
5. Click NEXT.
7. On the Configure Database screen, select one of the following options:
   • SQL Server Authentication—This option is selected by default. To configure SQL server authentication, enter the WDM database server credentials.
   • Windows Authentication—Enter the WDM database server details such as server name, instance name, database name, password and port number. The Username field is grayed out.

   NOTE:
   • The default port number is 1433. Dell recommends that you manually enter the port number since it is dynamic. You can add five-digit custom port for TCP/UDP in the range of 49152-65535.
   • Select Windows Authentication if you want to connect to the WDM database using your Windows login credentials.
8. Click NEXT.
9. Select the services you want to install, and click NEXT.

   NOTE: DHCP Proxy is selected by default.
10. Enter the installation path, and click NEXT.
11. Select and import the certificate to start the installation.

   NOTE: If you click the NEXT without selecting a certificate, the installer installs a self signed certificate. The communications are encrypted, but the system is not secure. The certificate must be in the format of .pfx file.

   The installation progress is displayed on the screen. After the installation is complete, you are prompted to restart your system.
12 Restart the system for the changes to take effect.

NOTE: In distributed environment, Web UI can be installed on a multiple console.
Upgrading WDM

Prerequisites

The current version of WDM supports an upgrade from WDM version 5.7.2/5.7.2 hot fix release. You cannot upgrade from any other version. If you are running an older version of WDM, you must first upgrade to version 5.7.2/5.7.2 hot fix release and then upgrade to the latest version.

1. **NOTE:** After you upgrade to WDM version 5.7.3, you must upgrade all devices with the latest Agents packages available to make sure your devices can be managed using WDM. For more information, see the WDM 5.7.3 Release Notes at support.dell.com.

Task

1. Extract the contents of the WDM installer on the system where you have installed WDM version 5.7.2/5.7.2 hot fix release.
2. Navigate to the folder where you have extracted the installer and run Setup.exe.

   The **Welcome** screen is displayed.
3. Click **Next**.

   The **Upgrade Information** screen is displayed.
4. Click **Next**. The **User Credentials** screen is displayed.
5. Enter the password.

   **IMPORTANT:** The Password field is disabled for SQL Authentication. You are required to enter the password only for Windows Authentication.
6. Click **Next**.

   The **Important Information** screen is displayed.
7. Read the **Important Information**, and click **Next**.

   The upgrade process begins.
8. After the upgrade process is complete, click **Restart Now** for the system changes to take effect before you start using WDM.

   **NOTE:** ThreadX 5.x is installed automatically if ThreadX 4.x is already installed on the system with windows 2012 and above versions.

Configuring Secure Communications

Configuring Secure Communication using SSL:

There are different ways to install SSL in IIS 6.0 and IIS 7.0. The procedures to configure SSL in IIS 6.0 and IIS 7.0 are given below.

Configure SSL in IIS 7.0 on Windows Server 2008 R2

To configure SSL in IIS 7.0:

1. Download SelfSSL7 utility from the link SelfSSL.exe.
2. Call the utility SelfSSL7.exe with the below mentioned parameters:
   
   ```cmd
   SelfSSL7.exe /Q /N cn=Certificate_Name /I /S Web_Site_Name. e.g. SelfSSL7.exe /Q /N cn="TestCert.TestLab.com" /I /S "Default Web Site"
   ```

   **Configuring Secure Communication Using Root Certificate Authority**

   **Installing Root Certificate Authority in IIS 7 on Windows Server 2008 R2**

   Use the following guidelines:
In order to install the certificate, two steps need to be followed:

- Install the certificate on Domain Controller server.
- Install the certificate on WDM server.

**Installing the Certificate on the Domain Controller Server**

Use the following guidelines:

1. Go to the **Server Manager**.
2. In the tree pane select **Roles** -> **Add Roles**.
3. In Add Roles wizard, select **Server Roles** from the tree pane.
4. In select **Server Role** window, check **Active Directory Certificate Service** from **Roles**.
5. Click **Next** -> **Next**. Then in **Role Services**, check the options **Certification Authority** and **Certificate Authority Web Enrolment**.
6. After checking the option **Certificate Authority Web Enrolment**, if IIS is not installed in the server, another window Add Required Role Services window will appear.
7. On the above window, click **Add Required Role Services** button and click **Next** to invoke **Specify Setup Type** window.
8. In the above window depending on the requirement select either **Enterprise** or **Standalone** radio button and click **Next** to open **Specify CA Type** window.
9. In **Specify CA Type** window, depending on the requirement select either **Root CA** or **Subordinate CA** radio button and click **Next** to open **Set Private Key** window.
10. In **Set Private Key** window, depending on the requirement select either **Create a new private key** or **Use existing private key** radio button and click **Next** to open **Specify Private Key** window.
11. In **Configure Cryptography for CA** window, depending on the requirement select the value for field **Select a cryptography service provider (CSP)** from the combo box, provide the **Key character length** from the combo box, select the value for field **Select the Hash algorithm for signing certificate issued by this CA** and either check or uncheck **Allow administrator interaction when the private key is accessed by the CA** check box and click **Next** button to open **Configure CA Name** window.

| NOTE: | Common name of the certificate should match with WDM server's computer name. |

12. In **Configure CA Name** window, provide the values for **Common name for this CA** and **Distinguished name suffix** fields and click **Next** to open **Set Validity Period** window.
13. In the **Set Validity Period** window, select the validity period for the certificate generated for this CA and click **Next** to open **Configure Certificate Database** window.
14. In **Configure Certificate Database** window, select the **Certificate database location** and **Certificate database log location** and click **Next** to open **Add Roles Wizard** window for IIS.
15. Select the default values and click **Next** -> **Install**.
16. It will install the **Active Directory Certificate Services**, **Web Server (IIS)** and **Remote Server Administration Tools**.
17. Once the installation of certificate is over, go to the **Internet Information Services Manager** of the domain controller.
18. In the **Server Manager** tree pane, expand **Roles**, and then click **Web Server (IIS)** -> **Internet Information Services (IIS) Manager** to open IIS Manager window.
19. In the tree pane select the **Server** and on the right pane double click **Server Certificates**.
20. In the right pane of **Server Certificates**, double click **Create Domain Certificate**, to begin creating a certificate.
21. Fill in the information requested in the **Create** window and click **Next** to open **Online Certification Authority**.
22. In **Online Certification Authority**, click **select** to **Specify Online Certification Authority** and provide a **Friendly Name** for the same and click **Finish**.
23. Now the installation of certificate in domain controller server is done, go to the installation of certificate on WDM server.

**Installing the Certificate on the WDM Server**

Use the following guidelines:

1. On the taskbar, click **Start** -> **Administrative Tools** -> **Internet Information Services (IIS) Manager** to open the IIS Manager window.
2. In the tree pane, click the **Server** and on the right pane double click **Server Certificates** to open **Server Certificates** Window.
3. Fill in the information requested in the **Create Certificate** window and click **Next** to open **Online Certification Authority**.
4. In **Online Certification Authority**, click **select** to **Specify Online Certification Authority** and provide a **Friendly Name** for the same and click **Finish**.
Now the installation of certificate in WDM server is done.

After the installation of certificate, browse through **Server -> Web Sites -> Rapport HTTP Server** and click **Bindings**... on right most pane to open **Site Bindings** window.

In **Site Bindings** window, click **Add** to **Add Site Binding**.

In **Add Site Binding**, select the recently created **certificate** from SSL Certificate combo box and click **OK** button.

In order to start only HTTPS communication, select **SSL Settings** under **Server -> Web Sites -> Rapport HTTP Server**.

In **SSL Settings**, select **Require SSL** check box and **Apply** the setting.

### Installing Root Certificate Authority in IIS 7 on Windows Server 2012 R2

Use the following guidelines:

- In order to install the certificate, two steps need to be followed:
  - Install the certificate on Domain Controller server
  - Install the certificate on WDM server

  **Install the certificate on Domain Controller server:**

  Use the following guidelines:

  1. Go to the Server Manager.
  2. In the **Dashboard** >> select option 2 **Add Roles and features**.
  3. In Add Roles and Features wizard, select Installation Type as >> Role-based or feature-based installation.
  4. In Server Selection >> Select a server from the server pool (By default local server will be selected).
  5. Then in Server Role window, select Active Directory Certificate Services’ Role.
  6. Selecting Active Directory Certificate Services Role will launch the Add Role and Features Wizard’ will auto launch with sub-features>> Click on Add Features button.
  7. Click Next->Next. Then in Features window, leave the default values as it is and click Next.
  8. Then in AD CS window appears and click Next button.
  9. In Role Service window, select the options Certification Authority and Certificate Authority Web Enrolment.
  10. After selecting the option Certificate Authority Web Enrolment, if IIS is not installed in the server, another window Add Features that are required for Certification Authority Web Enrollment sub-window will appear.
  11. On the above window, click on Add Feature button and click Next to Confirmation window.
  12. Then click on ‘Install’ button to install the AD Certificate role.
  13. In the Results window, Feature installation progress can be viewed.
  14. After Installation succeeds for AD Certificate Authority role, click on ‘Close’ button.
  15. Then in the Server Manager>> Dashboard console under notifications’ find the Post-deployment Configuration message.
  16. In Post-deployment Configuration message click on link “Configure Active Directory Certificate Services on the local server”.
  17. Then AD CS Configuration>> Credentials window will open get launched; provide the required appropriate credentials and click on ‘Next’ button.
  18. Then under Role Services>> select the options Certification Authority and Certificate Authority Web Enrolment and click ‘Next’ button.
  19. Then in the Setup Type window, depending on the requirement select either Enterprise or Standalone radio button and click Next to open CA Type window.
  20. In CA Type window, depending on the requirement select either Root CA or Subordinate CA radio button and click Next to open Private Key window.
  21. In Private Key window, depending on the requirement select either Create a new private key or Use existing private key radio button and click Next to open Configure Cryptography for CA window.
  22. In Configure Cryptography for CA window.
     - depending on the requirement select the value for field Select a cryptographic service provider (CSP) from the combo drop down box,
     - Provide the Key length from the next combo box
     - Select the value for field Select the Hash algorithm for signing certificate issued by this CA
and then either check or uncheck "Allow administrator interaction when the private key is accessed by the CA" check box
And click Next button to open Configure CA Name window. NOTE: Common name of the certificate should match with WDM server's computer name.

23. In CA Name window, provide the values for Common name for this CA and Distinguished name suffix fields and click Next to open Validity Period window.
24. In the Specify Validity Period window, select the validity period for the certificate generated for this CA and click Next to open Certificate Database window.
26. Then in Confirmation window, click on Configure button which will launch the progress window.
27. Then in the Results window, Certification Authority and Certification Authority Web Enrollment Configuration succeeded message will appear.
28. Click on Close button to finish the configuration of AD CS.
29. Now the installation of certificate in domain controller server is done, go to the installation of certificate on WDM server.

Installing the Certificate on the WDM Server:

Use the following guidelines:

1. On the taskbar, click Start->Administrative Tools->Internet Information Services (IIS) Manager to open the IIS Manager window.
2. In the tree pane, click on the Server and on the right pane double click on Server Certificates to open Server Certificates Window.
3. Click on Create Domain Certificate link on right most pane and fill in the information requested in the Create Certificate window and click Next to open Online Certification Authority.
4. In Online Certification Authority, click select to Specify Online Certification Authority (created in your AD Controller machine or in your setup) and provide a Friendly Name for the same and click Finish.
5. Now the installation of certificate in WDM server is done.
6. After the installation of certificate, browse through Server -> Sites->Rapport HTTP Server and click on Bindings... on right most pane to open Site Bindings window.
7. In Site Bindings window, click Add to Add Site Binding
8. In Add Site Binding, select Type as HTTPS, and select Certificate Authority under IP Address, select the recently created certificate from SSL Certificate combo drop down box and click OK button.
9. In order to start only HTTPS communication, select SSL Settings under Server->Web Sites->Rapport HTTP Server.
10. In SSL Settings, select Require SSL check box and ‘Require’ radio button for Client certificate and Apply the settings.
Uninstalling standalone installation of WDM

About this task
If you have a standalone installation of WDM, where all the components are installed on the same system, then you can follow the steps given below to uninstall WDM.

Steps
1. Go to Start > Control Panel.
2. Click Programs > Uninstall a program.
3. Select WDM 5.7.3 from the program list, and click Uninstall.
   The Uninstallation screen is displayed.
4. Click Next on the Welcome screen.
5. Enter the credentials to access the WDM database.
   You need to specify the SQL login credentials for SQL Server or SQL Express depending on where you have installed the WDM database.
   If you specify the wrong credentials, the error message Unable to connect to database is displayed.
6. Click Next.
   After the components are uninstalled, you are prompted to restart your system.
7. Click Restart Now to complete the uninstallation process.

Next step
After the Uninstallation, ensure that you meet the following checklists:

- WyseDeviceManager 5.7.3 WebUI icon should be removed from the desktop.
- In IIS, HApi Application should be deleted under Rapport HTTP Server.
- In IIS, MyWDM Application should be deleted under Rapport HTTP Server.
- In IIS, WebUI Application should be deleted under Rapport HTTP Server.

Uninstalling WDM in a distributed setup

About this task
If you have installed WDM in a distributed setup, then you need to uninstall the components one by one on the systems where you have installed them.

1. **NOTE:** You must uninstall all the other components on the systems where you have installed them, before you uninstall the WDM database.

Steps
1. Log in to the system or systems where you have installed the Management Server, Management Console, Other Services, Software Repository, and the Web UI.
2. Go to Start > Control Panel.
3. Click Programs > Uninstall a program.
4. Select WDM 5.7.3 from the program list, and click Uninstall.
   The Uninstallation screen is displayed.
5. Click Next on the Welcome screen.
6. Click Next to begin the uninstallation process.
7. Log in to the system where you have installed the WDM database.
Repeat steps 2 to 5.

Enter the credentials to access the WDM database.
You need to specify the SQL Login ID and password for SQL Server or SQL Express depending on where you have installed the WDM database.

If you specify the wrong credentials, the program displays the following message: *Unable to connect to database*. Make sure you enter the correct credentials.

Click **Next** to begin the uninstallation process.

After the database is uninstalled, restart the system when prompted.
Configuring High Availability database clustering for WDM

High-availability clusters (also known as HA clusters or failover clusters) are groups of computers that support server applications that can be reliably utilized with a minimum down-time. They operate by harnessing redundant computers in groups or clusters that provide continued service when system components fail.

If a server running a particular application crashes, then without clustering, the application is unavailable until the crashed server is fixed. HA clustering remedies this situation by detecting hardware/software faults, and immediately restarting the application on another system without requiring administrative intervention. This process is termed failover.

HA clusters usually use a heartbeat private network connection which is used to monitor the health and status of each node in the cluster.

The most common size for a HA cluster is a two-node cluster.

Topics:
- Components Required for Database Clustering
- Pre-requisites for Database Clustering
- Configuring the Primary and Secondary VMs
- Creating a Cluster on the Primary Node
Components Required for Database Clustering

The high availability environment for WDM consists of the following components:

- **Primary Server or Primary Node** – This is one of the four Virtual Machines (VMs) on which you need to install Microsoft SQL Server 2012 database. This should have two network adapters, one configured for public and one configured for private.

- **Secondary Server or Secondary Node** – This is the second VM and ensures high availability when the primary server fails. This should also have two network adapters, one configured for public and one configured for private.

- **Server for the Quorum folder** – This is the third of the four VMs and is needed to create the Quorum folder.

- **WDM Server** – This is the fourth VM on which you need to install WDM.

Pre-requisites for Database Clustering

Database Clustering requires the following:

- Four VMware Virtual Machines (VMs) out of which two VMs should contain two network adapters each.

- Supported version of Microsoft SQL Server Database (standalone version). For more information on supported databases, see Support Information.

  **NOTE:** The steps for database clustering discussed in this guide are performed on Microsoft SQL Server 2012. However, database clustering is supported on other supported versions of SQL Server.

  All the VMs should be connected to an Active Directory (AD) domain.

- All the four VMs should have Windows Server 2008 R2 Enterprise installed on them.

  **NOTE:** You cannot use SQL Server Express for database clustering.

Configuring the Primary and Secondary VMs

After you create the VMs on the server, you must configure them to support clustering. You must configure both the primary and the secondary nodes by following the steps given below.

**About this task**

To configure the primary and secondary VMs

**Steps**

1. Launch the vSphere client on any system on the network and select the VM.
2. Right click and select **Edit Settings**. Click **Add** to add one more network adapter (also referred to as node).
3. In the **Add Hardware** screen, select **Ethernet Adapter** and click **Next**.
4. Select the Subnet from the **Network label** drop-down list and click **Next**.
5. Click **Finish**.
6. In the **VM Properties** screen, check that there are two nodes.
7. Launch the **Network Connections** screen from **Control Panel** → **Network and Internet** → **Network Connections** and rename the network connections to **Private** and **Public**.

  **NOTE:** There must be two subnets for two network cards i.e. one subnet for the Public network (PDB) and one subnet for the Private network (PDB), and the same for the two network cards on the SDB server.

8. Make sure that the **Public Network** option is first in order in the **Advanced Settings** window.
To launch the Advanced Settings window, press the Alt button to access the Advanced menu in the Network Connections screen and select the Advanced Settings option.

In the Network Connections screen, select Public, right click and select Properties.

In the Advanced Settings window, select IPv4 and click Properties.

Enter the IP address, Subnet mask, Default gateway and the Preferred DNS server. Click OK.

Repeat steps 10 and 11 for the Private network.

Make sure that the Private network contains only the IP address and Subnet mask. The Default Gateway or DNS Servers should not be defined.

Make sure that the servers can communicate across this network so that the nodes can communicate with each other across the network.

Launch the Server Manager from Start → Administrative Tools. Select Features.

Click Add Features to launch the Add Features wizard.

Select Failover Clustering and click Next.

Make sure that the Failover Clustering option appears in the Confirm Installation Selections screen. Click Install. The installation progress is displayed.

After installation completes, check the installation results and click Close.

After the Failover Clustering installation is complete, reboot the server.

Validating a Configuration

About this task
After you install Failover Clustering, you must validate the configuration on the primary node. To validate the configuration:

Steps
1. Launch the Server Manager of the primary node from Start → Administrative Tools.
2. Select Failover Cluster Manager under Features.
3. Click Validate a Configuration to launch the wizard.
4. Click Next to add the primary and secondary nodes.
5. Enter the hostname of the primary node.
6. Click Add to select the servers. The screen displays the following message while adding the servers: “The operation is taking longer than expected”. You need to wait for a few minutes for the servers to be added.
7. After the servers are selected, they are displayed under Selected Servers. Click Next.
8. A multi-site cluster does not need to pass the storage validation. To skip the storage validation process click Run only the tests I select and click Next.
9. In the Test Selection screen, uncheck the Storage option and click Next to continue.
   The Confirmation screen is displayed.
10. Click Next to start running the validation tests on the primary and secondary nodes (in this case cluster1 and cluster2). The status of the validation tests are displayed on the screen.
11. View the validation summary and click Finish.

Creating a Cluster on the Primary Node

About this task
After you install and validate the Failover Cluster Manager feature on the primary node, you can create a cluster.

To create a cluster on the primary node:

Steps
1. Launch Server Manager on the primary node, select Failover Cluster Manager under Features, and click Create a Cluster.
2. Click Next on the wizard.
3. Click Next to continue and in the Select Servers screen, enter the hostname of the primary node, and click Add to add the server.
Enter the name of the secondary node and click **Add**.

After the servers are added, click **Next** to continue. You are prompted to validate your cluster. Select **No** since your cluster is validated.

Select the second option on the screen and click **Next** to continue.

Provide a name for the cluster and an IP for administering the cluster. The name you provide is to administer the cluster. This should not be the same as the name of the SQL Cluster resource that you will create later. Enter **WINCLUSTER** as the name of the cluster and enter the IP address. Click **Next** to continue.

**NOTE:** This is also the computer name that you need to provide permission for the File Share Majority Quorum, that is described later in this document. For more information, see **Implementing a Node and File Share Majority Quorum**.

Confirm and click **Next**.

The cluster forming progress is displayed on the screen. If you have performed all the steps correctly, then the cluster formation is successful. If you see the yellow warning symbol on the screen, then it indicates that the cluster formation was successful, but with warnings.

Click **View Report** to view the warnings while forming the cluster. The report is displayed with warning messages highlighted in yellow.

Ignore the warning messages and click **Finish** to complete the cluster formation process.

**Implementing a Node and File Share Majority Quorum**

A quorum is a design to handle the scenario when there is a problem with communication between sets of cluster nodes, so that two servers do not try to simultaneously host a resource group and write to the same disk at the same time. By having this concept of quorum, the cluster will force the cluster service to stop in one of the subsets of nodes to ensure that there is only one true owner of a particular resource group. The Node and File Share Majority quorum configuration is usually used in multi-site clusters. This configuration is used when there is an even number of nodes in the cluster, so it can be used interchangeably with the Node and Disk Majority quorum mode. In this configuration every node gets 1 vote, and additionally 1 remote file share gets 1 vote.

**About this task**

To configure a Node and File Share Majority Quorum:

**Steps**

1. Select the VM identified for creation of the quorum folder, and create a folder called **Quorum** and share the folder location.
2. Right click on the **Quorum** folder and select **Share with → Specific people**.
3. In the **File Sharing** window, select **Everyone**. Select the **Read/Write permission** and click **Share**. The folder is shared as `\<Name of the VM>\Quorum`.
4. You now need to change your quorum type. Launch the **Server Manager** on the primary node, and select **Failover Cluster Manager** under **Features**.
5. Right click on your cluster and select **More Actions → Configure Cluster Quorum Settings**.
6. Select the **Node and File Share Majority (for clusters with special configurations)** option and click **Next**.
7. Enter the path of the shared folder that you have created on the third VM and click **Next**.
8. Confirm the shared folder location and click **Next**. The quorum settings for the cluster are successfully configured.
9. Click **Finish** to complete the process and view the quorum configuration for the cluster.

**Installing .NET Framework on Primary and Secondary Nodes**

**About this task**

Microsoft .NET Framework is a pre-requisite to install SQL Server Standalone 2012 (or any other supported version of SQL Server) on the primary and secondary nodes.

To install the .NET Framework:

**Steps**

1. Launch **Server Manager** on the VMs you have identified for the primary and secondary nodes.
2. Click on **Features** under **Server Manager** to launch the **Add Features Wizard** and select **.NET Framework 3.5.1 Features**.
3. Click **Next** and you will prompted to install the required rol services and features to install .NET Framework 3.5.1 features.
Click Add Required Role Services. The option .NET Extensibility is selected by default. Click Next to continue.

5 Confirm the installation selections and click Install.

6 After the installation of the selected components is complete, the installation results are displayed.

7 Click Close to complete the .NET Framework installation.

Installing SQL server on primary and secondary Nodes

Installing SQL Server on both the nodes and configuring it to function in a cluster is an important step in the setup of a high availability database cluster. This section provides the steps to install and configure SQL Server 2012 standalone on both the nodes. If you want to install any of the supported versions of SQL Server, see the installation instructions provided by Microsoft.

To install a standalone version of SQL Server 2012 on the both the nodes:

1 Launch the SQL Server 2012 installation media.
2 Click Installation and select New SQL Server stand-alone installation or add features to an existing installation.
3 Make sure that the Setup Support Rules does not display any failures. Click Next to continue.
4 Enter the Product key and click Next.
5 Check the product update and click Next.
6 Accept the license agreement and click Next.
7 Select the SQL Server Feature Installation option and click Next.
8 In the Feature Selection screen, select the Database Engine Services features and all the features under it.
9 Select the Management Tools – Basic feature and the feature under it. Click Next.
10 Make sure that the Installation Rules screen does not display any failures. Click Next.
11 In the Instance Configuration screen, make sure that the Default instance option is checked.
12 Click Next to view the Disk Space Requirements.
13 Click Next to view the Server Configuration.
14 Enter the domain credentials for server configuration and click Next.
15 In the Database Engine Configuration screen, select Mixed Mode and enter the SQL Administrator password and click Add Current User.
16 Click Next on the Error Reporting window.
17 Click Next and make sure that the installation configuration rules does not display any failures.
18 Click Install to begin the installation process.
19 After the installation completes, the installation status is displayed. View the status and click Close to complete the installation.

NOTE: If you encounter the Windows Firewall Warning while installing SQL Server, you can ignore the warning and continue with the installation. If required, you can add port 1433 to the SQL Server firewall exception.

Installing SQL Server Failover Cluster on Primary Node

After you complete installing SQL Server 2012 on both the primary and secondary nodes, you need to configure both the nodes to support the failover clustering.

To install the SQL Server 2012 failover cluster on the primary node:

1 Launch the SQL 2012 Server Installation media.
2 Click Installation and select New SQL Server failover cluster installation.
3 Make sure that the Setup Support Rules screen does not display any failures. Click OK.
4 Enter the product key and click Next.
Accept the license terms and click Next.

Check the product updates and click Next.

Make sure that the Setup Support Rules screen does not display any failures or errors. You can ignore the warnings and click Next.

Select the SQL Server Feature Installation option in the Setup Role screen and click Next.

Select all the options under Instance Features → Database Engine Services and Shared Features → Client Tools Connectivity on the Feature Selection screen. Click Next.

Make sure that the Feature Rules screen does not display any failures. Click Next.

In the Instance Configuration screen, enter the following details:

- SQL Server Network Name – WDMCLUSTER
- Named Instance – WDMCLUSTER
- Instance ID – WDMCLUSTER

Click Next.

Check the Disk Space Requirements and click Next.

Leave the default settings on the Cluster Resource Group screen and click Next.

Since you have configured a File Share Majority clustering, you do not need to select any disk. Click Next on the Cluster Disk Selection screen.

In the Cluster Network Configuration screen, enable IP4 and provide the IP address for the SQL Failover cluster and click Next to proceed to the Server Configuration screen.

Enter the domain credentials for the SQL Server Agent and SQL Server Database Engine and click Next.

In the Database Engine Configuration screen, select the Mixed Mode (SQL Server authentication and Windows authentication) option and enter the SQL Administrator password.

Click Add Current User to add the Administrator user and click Next.

You will be prompted to install a SQL Failover Cluster. Click Yes on the prompt.

Click the AlwaysOn High Availability tab on both the nodes and select Enable AlwaysOn Availability Groups. Click OK.

Install the WDM database on VMs that you have identified as the primary and secondary nodes of the cluster.

Post Clustering Procedure

About this task
This section discusses the various steps you need to perform after you complete the cluster setup. These steps enable your cluster to function smoothly without any issues.

Follow the steps given below:

Steps
1. In both the cluster nodes, make sure that the SQL Server Services are started up with the domain credentials.
2. Launch the SQL Server Configuration Manager and select SQL Server Services → SQL Server. Right click and select Properties.
3. Check the domain credentials and click OK.
4. Click the AlwaysOn High Availability tab on both the nodes and select the Enable AlwaysOn Availability Groups. Click OK.
5. Install the WDM database on VMs that you have identified as the primary and secondary nodes of the cluster.
Run the following script on the database:

```
USE RapportDB
GO
UPDATE Install SET ServerName='NEWCLUSTER01' WHERE Module='Rapport4DB'
```

When you install the WDM components without the database, make sure you provide the name of the SQL Database Cluster name in the Server IP Address field.

Create the same directory structure pointing to the database location both in the primary as well as the secondary node. For example, if the database is present in `C:\Program Files\WYSE\WDM\Database` in the primary node, create the same structure in the secondary server as well.

Launch the SQL Server Management Studio on the primary node. Login with the default SQL user name and password.

Right-click on `RapportDB` database and select `Properties`.

In the `Database Properties` screen, change the `Recovery Model` to `Full`.

Right-click on the `RapportDB` and select `Tasks` → `Backup` to take a backup of the RapportDB.

Leave the defaults on the `Backup Database` screen and click `OK`.

Right-click on `AlwaysOn High Availability` in the Object Explorer and select `New Availability Group Wizard`.

Click Next on the `New Availability Group Wizard` screen.

Provide a name for the Availability group such as `Rapport_cluster` and click Next.

Select the database and click Next.

Click `Add Replica` and select the `Automatic Failover (up to 2)` and `Synchronous commit (up to 3)` check-boxes.

Repeat the step for the secondary node.

Click Next.

Select the `Full` option and specify the shared folder location as `\<Name of the Quorum Machine>\quorum`. Click Next.

Make sure that the `Validation` screen does not display any failures. Click Next.

If you see any warnings on the screen, you can ignore them and proceed with the installation.

Click Finish to complete installing the `New Availability Group`.

The progress window displays the progress of the installation. Click Next when installation completes.

View the results and click Close.

The primary and secondary nodes are displayed on the SQL Server Management Studio.

Shutdown the secondary node and check to make sure that the primary node is running in the cluster.

Launch the SQL Server Management Studio on the primary node. Login with the default SQL user name and password.

Click the `Security` node, select `Login`, right-click and select `New Login` to create the Rapport user. This step is important for WDM to function as you are creating the SQL Server Authentication user.

Select `Server Roles`, select the `sysadmin` check-box and click OK.

View the Rapport user on the SQL Server Management Studio.

Repeat steps 28 — 31 on the secondary node.

**Next step**

**NOTE:** If there is a fail-over from the primary database to the secondary database, you must restart the WDM UI.

### Running the HA Configuration Utility

**About this task**

WDM needs to connect to the cluster in order to function within the cluster and ensure that there is zero downtime.

The High Availability Configuration Utility is available after you install WDM on a separate node other than the primary and secondary nodes.

**Steps**

1. Log in to the system where you have installed WDM.
2. Launch the `HAConfigureUtility` from `Start` > `All Programs` > `Dell Wyse Device Manager` > `Utilities`.
3. Enter the following details:
   - `Configure Setup As` – select `Cluster` from the drop-down list.
   - `Database Name` – this is displayed by default and cannot be edited.
• **Database Server** – Specify the hostname of the database cluster. For example, **WDMCLUSTER**.
• **Database User Name** – Specify **rapport** as the database user.
• **Database Password** – Specify the password of the rapport user.
4 Click **Configure**.
   The connection details are displayed on the bottom pane of the utility.

### Adding a License on WDM

**About this task**

WDM needs a license to function. The licensing code is generated based on the database. WDM is normally installed on a standalone database and then moved to a cluster. Therefore, after your cluster setup is complete, you need to generate the license code again for the cluster.

To add a license on WDM for the WDM server:

**Steps**

1. Launch Wyse Device Manager (WDM). The following error is displayed: “Application Function: Scopelitems_Expand: 13 Type mismatch”.
2. Click **OK** and add the license from the WDM console.
3. To initiate failover, shutdown the database on the primary node and restart the WDM Console.
When you use WDM to manage thin client devices in a very large enterprise environment, a single WDM Management Server cannot scale up to manage the large number of devices. There could be problems or delays in client check-ins, schedule execution, or real-time command execution.

Load balancing helps resolve these problems to a great extent. In this setup, you can install and run multiple instances of WDM Management Servers on different systems and configure the load balancing feature between them. WDM uses the Microsoft Application Request Routing (ARR) for IIS 7 feature to perform load balancing between the management servers. This section describes how to setup and configure load balancing.

**Figure 39. WDM load balancing setup**

**Topics:**
- Setting up the ARR Proxy Server
- Installing WDM Components
- Configuring Load Balancing for ThreadX 4.x Devices
- Configuring load balancing for ThreadX 5.x devices

### Setting up the ARR Proxy Server

The Application Routing Request (ARR) Proxy server is the most important component of Load Balancing. This server receives the requests from the thin client systems and routes them to the different WDM Management servers.

**Prerequisites**
Before you set up the ARR Proxy server, you must make sure of the following:
The entire setup should be on Windows 2008 Server R2 or higher.
- Install all the components of WDM on one server.
- Install only the WDM Management Server and ThreadX 4.x service on another server.

1. **NOTE:** You can set up the ARR Proxy Server and the WDM Management Servers across different subnets in the same domain.

**About this task**
Setting up the ARR Proxy Server consists of the following steps:

**Steps**
1. Installing IIS.
2. Installing the ARR Module.
3. Configuring the Application Pool Process for ARR.
4. Creating a Server Farm of WDM Management Servers.
5. Configuring SSL.
6. Configuring Server Farm Properties for ARR.
7. Configuring Request Filtering.
8. Setting up the Proxy FQDN in WDM Preferences.

---

**Installing Internet Information Services— IIS**

**About this task**
Install Windows 2008 Server R2 on any of the systems that you identify to be the ARR Proxy Server.

**Steps**
1. Log in as an administrator and run the **Server Manager**.
2. Select **Roles** under Server Manager and click **Add Roles** on the right-hand pane.
   - The **Add Roles Wizard** is displayed.
3. Select **Server Roles**, check **Web Server (IIS)**, and click **Next**.
Select the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Sub-options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common HTTP Features</td>
<td>• Static Content • Default Document • Directory Browsing • HTTP Errors • Directory Browsing</td>
</tr>
<tr>
<td>Health and Diagnostics</td>
<td>• HTTP Logging • Request Monitor • Logging Tools • Tracing</td>
</tr>
<tr>
<td>Management Tools</td>
<td>Select all the sub-options.</td>
</tr>
</tbody>
</table>

5 Click **Next** to view the summary.

6 Click **Install** to install IIS.

**Installing the ARR Module**

You must install the Application Request Routing version 3.0 on the system you have identified to be the ARR Proxy Server. The installer is available on the Microsoft download site at [https://www.microsoft.com/en-us/download/details.aspx?id=47333](https://www.microsoft.com/en-us/download/details.aspx?id=47333). Download the **ARRv3_0.exe** file and install it.
Configuring the Application Pool Process for ARR

All HTTP requests and responses for the content sites go through Application Request Routing. For this to function correctly you must make sure that the worker process of the Default Web Site on ARR is always running.

About this task
To configure the application pool process:

Steps
1. Log in to the ARR Proxy Server, and launch the IIS manager.
2. Select Application Pools under the root node.
   The right-hand pane displays DefaultAppPool as the application pool for the Default Web Site.
4. Select Advanced Settings to display the Advanced Settings window.

   ![Advanced Settings window](image)

5. Under Process Model change the value of Identity from LocalSystem to ApplicationPoolIdentity.
6. Change the Idle Time-out (minutes) to 0 to disable the setting. Click OK to save the changes.
Creating a Server Farm of WDM Management Servers

About this task
To create and define a server farm:

Steps
1. Log in to the ARR Proxy Server system and launch the IIS Manager.
2. Select Server Farms under the root node. This option is available only after you install the ARR Proxy module.
3. Right-click and select Create Server Farm from the menu.
   The Create Server Farm screen is displayed.

4. Enter a name for the server farm. For example, **WDMServerFarm**. Click Next to add the WDM Management servers.
5 Type the host name of the WDM Server and click Add. You can add all the servers where you have installed the WDM Management Server.

6 Click Finish to add all the servers to the farm.

After the servers are added and the server farm is created you are prompted with a message to rewrite the routing rules for all requests to automatically come to the server farm.

7 Click Yes so that IIS manager can create a URL rewrite rule to route all incoming requests to this server farm.

Configuring SSL

One of the features in ARR is SSL off-loading. This is a feature in which the communications between the clients and the ARR Proxy Server are done via SSL, and the communications between the ARR Proxy Server and the WDM Management Servers are done via clear text. By enabling this feature, you can help to maximize the server resources on the WDM Management Servers.

Prerequisite
You first need to create the SSL Certificate on the ARR Proxy Server.

About this task
To create and configure the SSL Certificate:

Steps
1 Log in to the ARR Proxy Server and launch the IIS Manager.
2 Select the root node and open the Server Certificates page from the right-hand pane.
3 Click Create Domain Certificate on the Action pane.
4 Provide the name of the ARR Proxy Server in the Create Certificate wizard.
5 Click Next to complete creation of the certificate.
6 Select Default Web Site under Sites and click Bindings on the Actions pane.
7 Assign the certificate to HTTPS binding.
8 Go to the Server Farm and double click the Created Farm.
Double click on **Routing Rules** and select the **Enable SSL offloading** option if you want the communication between the ARR Proxy Servers and the WDM Management Servers to be in plain text. You also need to add both the HTTP and HTTPS ports to the Default Web Site Bindings on the individual WDM Management Server systems.

**NOTE:**

If you want the communication between the ARR Proxy Server and the WDM Management Servers also to be on the HTTPS protocol, then you must disable the **SSL off-loading** feature and configure SSL on the individual WDM Management Servers. If you use a self-signed certificate setting up SSL on the WDM Management Server, then import this certificate to the **Trusted Root Certificate Authorities store** for a local computer on the ARR Proxy Server by following the steps available on Microsoft website: http://technet.microsoft.com/en-us/library/cc754841.aspx#BKMK_addlocal

---

## Configuring Server Farm Properties for ARR

After the server farm has been created and defined, you need to set additional properties to manage the behavior of ARR.

1. Log in to the ARR Proxy Server and launch the IIS Server Manager.
2. Select the Server Farm you created. The following options are displayed on the right-hand pane:
   - Caching
   - Health Test
   - Load Balance
   - Monitoring and Management
   - Proxy
   - Routing Rules
   - Server Affinity
3. Select **Caching**.
   - a. De-select the **Enable disk cache** option to disable caching.
   - b. Set the **Memory cache duration** to 0.
4. Select **Health Test**.
   - a. Enter the fully qualified domain name (FQDN) of the ARR proxy server in the **URL** field. The value should be: `http(s)/<ProxyFQDN>/hserver.dll?&V93`. This is the URL, which ARR uses to send requests to the WDM Management Server to check the Health for a particular server farm.
   - b. Set the **Interval time period** after which the ARR Health Test repeats the Health Check. The default is 30 seconds. You can set it to 180 seconds.
   - c. Set the **time out period** of the URL you specified. This is the time period during which if the server does not respond, it is marked as **Unhealthy**.
   - d. Set the **Acceptable Status codes** to 200–399. If the Health URL returns a status code that does not match with the value in the **Acceptable Status Codes**, then ARR marks that server as unhealthy.
   - e. Set the text value **Server Healthy** in the **Response Match** field. The text in **Response Match** is verified against the response entity from each server and if response from server does not contain the string specified in response match then that server is marked as unhealthy.
   - f. Click **Verify URL**. This should pass for all the WDM Management Servers in the server farm.
5. Change the **Load Balance** algorithm.
   - a. Select **Weighted Round Robin** from the **Load balance algorithm** drop-down list.
   - b. Select **Even distribution** from the **Load distribution** drop-down list.
   - c. Click **Apply**.
6. Double click the **Monitoring and Management** option to view the WDM Management Server health status and other statistics.
7. Double click **Proxy** to configure the proxy settings:
   - a. Change the **Response buffer threshold** value to 0.
   - b. De-select the **Keep Alive** option.
   - c. Change the **HTTP version** to **HTTP/1.1**.
   - d. Select the **Reverse rewrite host in response headers** option.
8. Double click **Routing Rules**.
   - a. Click **URL Rewrite** on the **Actions** pane.
In the **Edit Inbound Rule** page, set the **Pattern** to `*hserver.dll*`. This step ensures that the ARR Proxy Server forwards only the URL requests meant for the WDM Management Server to the Server Farm.

The Server Farm properties are now configured.

**Configuring Request Filtering**

**About this task**
To configure request filtering:

**Steps**
1. Log in to the ARR Proxy Server and launch the IIS Manager.
2. Select **Default Web Site** under **Sites** and on the right-hand pane double click on **Request Filtering**.
3. Click **Edit Feature Settings**.
4. Set the **Request Limits** as shown below:
5. Click **OK** to apply the settings.

![Edit Request Filtering Settings](image)

**Setting up Proxy FQDN in WDM Preferences**

To complete the Load Balancing setup, you need to specify the Proxy server details in WDM.

**About this task**
To setup the Proxy FQDN in WDM:

**Steps**
1. Log in to the system where you have installed WDM and start the WDM Web UI Console.
2. Select **System > Console**.
3. Under Manager Server Alias Name, enter the FQDN of ARR Proxy Server.
Click Save to save the settings.

The ARR Proxy Server is now recorded in the WDM database, and this completes the Load Balancing setup.

**Installing WDM Components**

The load balancing setup needs multiple installations of WDM Management Servers. However, you must make sure that one of the systems in this setup has a complete installation of WDM. You can then install only the Management Server and the ThreadX Service on the other systems. For more information on installing only the selected components, see Installing Management Server

**Configuring Load Balancing for ThreadX 4.x Devices**

When you want to manage a large number of PCoIP (ThreadX) devices, then a single ThreadX Manager Service may not scale up to manage the large number of ThreadX devices. Configuring load balancing for ThreadX devices helps you to manage a large number of such devices.

**Prerequisites**

Before you configure Load Balancing for ThreadX devices, you first need to identify a Windows 2008 R2 system and install the Domain Name Server (DNS) on the system.


The load balancing mechanism uses the DNS Round Robin method to share and distribute the network resource loads.

**About this task**

To set up the DNS Round Robin:

**Steps**

1. Log in to the DNS Server and launch the DNS Manager.
2. Select the server name on the tree in the left pane, right-click and select Properties from the menu. The Properties window is displayed.
3. Click the Advanced tab on the Properties window.
4. In the Server Options pane, make sure that the options Enable round robin and Secure cache against pollution are checked.
5. If you require netmask ordering, then select the Enable netmask ordering option. This feature tries to prioritize local resources for the clients.
6. Click the View menu on the DNS Manager and select the Advanced option.
7. Expand the Domain node and under Forward Lookup Zones, select the domain. For example, WDMSQA11.com.
8. Right-click and select New Host (A or AAAA).... The New Host window is displayed.
9. Enter the virtual host name of the ThreadX Server Farm that will participate in the load balancing. For example, ThreadXServer1. The FQDN of the server is displayed automatically.
10. Enter the IP address of the server.
11. Click Add Host.
12. Repeat steps 8–11 to add as many ThreadX Servers as you want.
13. Select the Domain node on DNS Manager, right-click and select Other New Records.
14. In the Resource Record Type dialog box, select SRV Location and click Create Record.
15. In the New Resource Record dialog box, enter the following values:
   - Service Name – _PCOIP-broker
   - Protocol – _tcp
   - Port Number – 50000.
   - Host Offering this Service – enter the hostname of the ThreadX Server Farm.
16. Repeat steps 13–15 to add the _PCOIP-tool SRV record.
17. Configure DNS Caching:
   a. On the DNS Manager, expand the Domain node and under it select the _tcp node.
   b. Select _PCOIP-tool on the right-hand pane, right-click and select Properties.
   c. In the Properties window, check the Time to live (TTL) value. The caching interval is called the Maximum TTL value and the default is 1 hour. You can change this if you want.
The TTL field is displayed only if you have selected Advanced View in the View menu of the DNS Server.

The load balancing is now configured for ThreadX devices and you can use the your WDM Management Servers to manage a large number of ThreadX devices.

**Configuring load balancing for ThreadX 5.x devices**

When WDM is used to manage ThreadX 5.x devices in a large enterprise environment, a single Teradici Device Proxy Server which is used to manage ThreadX 5x devices from WDM cannot scale up to manage more than 18 thousand devices. There could be problems or delays in client check-ins, schedule execution, and/or real-time command execution.

Load balancing helps resolve these problems to a great extent. In this setup, you can install and run multiple instances of Teradici Device Proxy Servers on different systems and balance the load between them using a proxy as described below.

The components of the load balancer are as follows:

- Teradici Device Proxy Server
- HA Proxy Server

WDM uses the HAProxy hosted on the Ubuntu server 16.04.1 LTS to perform load balancing between the Teradici Device Proxy servers. HAProxy is a load balancer proxy that can also provide HA based on how it is configured. It is a popular open source software for TCP/HTTP Load Balancer, and proxying solution which can be run on Linux. The most common use is to improve the performance and reliability of a server environment by distributing the workload across multiple servers.

This section describes how to set up and configure load balancing of the HA Proxy Server.

**Steps to create DNS_SRV Record:**

Firmware 5.x uses a DNS_SRV record in addition to the text record that contains the thumbprint of the SSL certificate to use in the management console.

WDM 5.7.3 supports Teradici 5.x firmware with comprehensive features.

1. The first record required is a DNS_SRV record for _pcoip-bootstrap. The record must point to the name of the Teradici Device Proxy (HAProxy).

   ![Figure 40. DNS_SRV record for _pcoip-bootstrap](image)

2. The second record required is an A record pointing to the name used in the Host offering this service field.
The third record required is a Txt record. The txt record is the thumbprint of the SSL certificate in use by the management console.

Complete the following steps to create A record for Host as well as Txt record:

1. Click the domain node (delldemo.int) and select the Other New Records and then select Host (A or AAAA), the name is the A record of the management console.

Figure 41. Host Record

Figure 42. Create TXT record
2. Click on the domain node (delldemo.int) and select the **Other New Records** and then select Text (TXT), to create the text field which has the thumbprint of the certificate.

![New Resource Record](image1.jpg)

**Figure 43. New Resource Record**

The SHA256 thumbprint can be obtained using Firefox browser.

To obtain the thumbprint when Wyse Device Manager (WDM) is installed with Teradici 5x:

1. You must open the Firefox browser from the device where Teradici 5.x component is installed. After opening the browser, press the `Alt + T` key to open Tools.
2. From the drop-down list, select **Options**.

![General Tab](image2.jpg)

**Figure 44. General Tab**

3. In the left pane of the **Options** page, click **Advanced** tab and then click **Certificates** option.
Figure 45. Advanced

4. Click View Certificates to open the Certificate Manager window.
5. Select the Authorities tab on the Certificate Manager window and click Import.
6 In the file browser dialog navigate to the location where WDM is installed. For example: `\Wyse\WDM\TeraDici`, where the root path can be `C:\Program Files (x86)` based on the operating system and installation path.

**NOTE:** In some cases if the Teradici components are installed in a custom manner or manually configured, the above steps must be followed on the same device, and the standard installer path may not be applicable. In such case navigate to the corresponding root path where Teradici folder is available.

7 Select the file with the name `cert.pem` and then click **Open**.

8 Now click the **View** button in the **Downloading Certificate** window.
Figure 47. Downloading Certificate

Copy the sha256 fingerprint value. Click Close and cancel all the firefox windows.
NOTE: In the Text field the text must be prefixed with pcoip-bootstrap-cert= to the sha256 fingerprint which is obtained already.

After copying the certificate fingerprint, complete the following steps on the DNS server:
10 The fourth and final record is a reverse PTR record for the management host.

11 The zone must match the subnet that the host is in, and the record is the IP address assigned to the Teradici Device Proxy (HAProxy).

**Installing and configuring HAProxy**

HAProxy which is the load balancer for ThreadX 5x devices is configured on Ubuntu Linux version 16.04.1 with HAproxy version 1.6.

Follow the steps to install and configure HAproxy on Ubuntu Linux machine:

Reference link: https://haproxy.debian.net/?distribution=Ubuntu&release=precise&version=1.6

1 Log in to Ubuntu machine by providing the user credentials used during the installation of Ubuntu operating system.

2 Open the terminal and execute the following commands to install HAProxy:
   - `sudo apt-get install software-properties-common`
   - `sudo add-apt-repository ppa:vbernat/haproxy-1.6`
   - `sudo apt-get update`
   - `sudo apt-get install haproxy`
Execute the following commands to configure HAProxy:

- Back up original configuration before editing, with the command `sudo cp /etc/haproxy/haproxy.cfg /etc/haproxy/haproxy.cfg.original`
- Now edit the configuration file with the command `sudo nano /etc/haproxy/haproxy.cfg`
- In the configuration file edit the following sections as per the requirement:
  - Global section: `Maxconn <maximum number of connections>`
  - Frontend tcp-in: `bind <HAProxy server IP>:5172`
  - Back end servers: `server <server alias name> <Teradici Device Proxy server IP>:5172`
  - `maxconn <maximum number of connections per Teradici Device Proxy server>`

**NOTE:** For achieving high availability, administrator may add additional back end servers beyond the total number of clients capacity to have seamless fail over.

- After editing the configuration, save it with command `Ctrl + O`
- The sample HAProxy configuration is provided as follows:

```
global
log /dev/log local0
log /dev/log local1 notice
chroot /var/lib/haproxy
daemon
#maxconn is maximum allowed connections
maxconn 50000

defaults
log global
mode tcp

timeout connect 5000ms

timeout client 50000ms

timeout server 50000ms
errorfile 400 /etc/haproxy/errors/400.http
errorfile 403 /etc/haproxy/errors/403.http
errorfile 408 /etc/haproxy/errors/408.http
errorfile 500 /etc/haproxy/errors/500.http
errorfile 502 /etc/haproxy/errors/502.http
errorfile 503 /etc/haproxy/errors/503.http
errorfile 504 /etc/haproxy/errors/504.http

frontend tcp-in
#replace IP with IP of your Linux proxy machine
bind 10.150.99.102:5172
```
default_backend servers

backend servers

#Add your multiple back end windows machine IP with 5172 as port

# maxconn represents number of connection- replace 10 with limit #(below 20000)

# server1 server2 are just names and not keywords

server server1 10.150.99.107:5172 maxconn 10
server server2 10.150.99.107:5172 maxconn 10

4 Now validate the HAProxy configuration file with the command `sudo haproxy -f /etc/haproxy/haproxy.cfg --c`.

If configuration is valid the following message will be shown:

Configuration file is valid

5 Now restart HAProxy service by using the following command:

Sudo service haproxy restart

6 Command to stop the HAProxy service

Sudo service haproxy stop

7 Command to verify the version of HAProxy

Sudo haproxy --f

8 Command to uninstall HAProxy

Sudo apt-get remove haproxy

or

Sudo apt-get purge --auto-remove haproxy

---

**Installing Teradici Device Proxy Servers**

Teradici Device Proxy servers can be installed on the servers which run the following operating systems:

- Windows 2012
- Windows 2012 R2
- Windows 2008 R2 x64bit
- Windows Server 2016

Follow the steps provided to install Teradici Device Proxy service:

1 Log in to the system as administrator.
2 Copy the WDM installer folder to the target machine.
3 Go to TeradiciDeviceProxy folder.
4 Double click the WDMTeradiciDeviceProxy.exe file to install the same.
5 Provide the following inputs:

   a Select the path where you want to install Teradici Device Proxy and its dependent components.

   b Select Cert.pem file from the folder `<WDM installed location>\Teradici` on the machine where ThreadX 5X component is selected while installing WDM.
Select `emsdk.keystore` file from the folder `<WDM installed location>\Teradici\EMSDK\config` on the machine where ThreadX 5X component is selected while installing WDM.

![Teradici Device Proxy Installation Details](image)

- Select installation directory for this utility
- Certificate File (cert.pem)
- EMSDK Keystore File (emsdk.keystore)
Provide the required inputs, and click **Next**.

The install log will be created at `<EMSDK Installed location>\Teradici\Detail_TeradiciDeviceProxy.log`.

Go to **Start** > **Administrative tools** > **Services**.

Verify that the ThreadX 5x Manager Windows Service is installed and running.

---

**Adding Teradici Device Proxy Servers to WDM**

**Tasks**

1. Open WDM Web UI and log in as administrator.
2. Go to **System** > **Console** and enable **Teradici Device Proxy servers** option.
3. Click **Add Server**.
4. Add the Teradici Device Proxy server name in the **Server Name** field and give port number of the Teradici Device Proxy service in the **Port Number** field. The default value is 49159.

**NOTE:** If the default port number is changed, it must be updated in WDM. For more information, see *Wyse Device Manager 5.7.3 Administrator’s guide.*
Click the check mark on the right hand side of the text boxes to save the values.

Adding HAProxy to WDM

Follow the steps provided to add HAProxy to WDM:

1. Log in to WDM Web UI as administrator.
2. Go to console page and enable HAProxy Server option.
3. Click Add Server.
4. Add the HAProxy Server name in the server name field and give port number as 5172.
5 Click **Add Server** again.

6 Click on the check mark on the right hand side of the text boxes to save the values.

## Restarting Threadx API

Follow the steps provided to restart Threadx API:

1. Log in to the server where WDM ThreadX 5x component is installed.
2. Click the Start menu > Administrative tools > Internet information service (IIS) manager.
3. Expand the root node (host name of the server) and select Application pools > ASP.Net v4.0.
4. Right click ASP.Net v4.0 and select Stop.
5. Again right click ASP.Net v4.0 and select Start.
6. Open WDM web UI and login as administrator.
7. Verify the status using the dashboard.

## Verify status from Dash board

1. Click on dash board and Select Teradici Servers.
2. Verify that Thread5x, Teradici HAproxy and Teradici Device proxy server status are Online.
Figure 51. Status on Dashboard

WDM Servers
Discovery and imaging
Scheduler
MASTER Repository
Teradici Servers

ThreadX 4X

wdm-IP99
Online
Last Check In: 23-02-2017 18:34:21
IP Address
10.150.225.99
Listening Port
543

ThreadX 5X

WDM-IP99
Online
Last Check In: 23-02-2017 18:29:20
IP Address
10.150.225.99
Listening Port
443

Figure 52. Status on Dashboard
Teradici Device Proxy Server

WDM-IP99

Online
Last Check In: 23-02-2017 18:34:21

IP Address
10.150.225.99

Listening Port
49159

---

HA Proxy Server

10.150.117.208

Online

IP Address
10.150.117.208

Listening Port
5172

Figure 53. Status on Dashboard
Configuring high availability of web UI service

When you have a single instance of web UI service and if that server goes down, then WDM cannot be managed from web UI. So a high availability (HA) of web UI service is recommended.

You can use load balancer proxy like ARR reverse proxy where the configuration has to be done to support high availability of web UI service.

Topics:
- Setting up the ARR Proxy Server
- Installing Internet Information Services—IIS
- Installing the ARR module
- Changing application pool process model for Application Request Routing
- Create a Server Farm of web UI servers
- Configuring SSL on the proxy server
- Configuring server farm properties for Application Request Routing
- Logging to the web UI browser

Setting up the ARR Proxy Server

The Application Routing Request (ARR) Proxy server is the most important component of Load Balancing. This server receives the requests from the thin client systems and routes them to the different WDM Management servers.

Prerequisite
IIS 7.0 or later version on Windows 2008 (any SKU) or later version must be installed.

About this task
Setting up the ARR Proxy Server consists of the following steps:
Steps
1. Install IIS.
2. Install ARR module.
3. Change application pool process model for Application Request Routing.
4. Create a Server farm of web UI servers.
5. Configure SSL on the proxy server.
6. Configure server farm properties for Application Request Routing.

Installing Internet Information Services—IIS

1. Log in as an administrator.
2. Go to Control Panel > Programs and Features > Turn Windows features on or off.
3. Select the options as shown in the following screenshot.

![Windows Features screenshot](image)

Figure 55. Windows features

4. Click OK.
Installing the ARR module

You must install the Application Request Routing version 3.0 on the system you have identified to be the ARR Proxy Server. The installer is available on the Microsoft download site at support.microsoft.com. Download the ARRv3_0.exe file and install it.

Changing application pool process model for Application Request Routing

About this task

All HTTP requests and responses for the content sites go through Application Request Routing. The worker process of Default Web Site on Application Request Routing must always be running regardless of whether the worker processes for some of the sites are running or not.

You must disable the Idle Time-Out under application pool process model for Default Web Site.

Steps

1. Start the IIS Manager.
2. Select Application Pools.
4. Go to Actions > Edit Application Pool > Advanced Settings.
5. Change the Idle Time-out (minutes) to 0.
Click **OK** to save the changes.

**Create a Server Farm of web UI servers**

1. Start the IIS Manager.
2. Right-click **Server Farms**, and select **Create Server Farm**.
Enter a name for the server farm.

Click Next.
On the **Add Server** page, add the application servers (WebUI servers).

![Add Server](image)

Figure 60. Add Server

Click **Finish** to create the server farm with the entered application servers as the server farm members.

The **Rewrite Rules** window is displayed.
Configuring SSL on the proxy server

To configure SSL on ARR Proxy, create a domain certificate for the proxy server. Assign this certificate to the https binding for the web site and enable SSL.
The communication between the ARR Proxy Server and the WDM Management Servers must be on HTTPS protocol. Hence, you must disable the SSL off-loading feature and configure SSL on the individual WDM Management Servers. If you use a self-signed certificate setting up SSL on the WDM Management Server, then import this certificate to the Trusted Root Certificate Authorities store for a local computer on the ARR Proxy Server by following the steps available on support.microsoft.com. IIS ARR requires a trusted certificate to exist between ARR and the back end server it connects to; otherwise it will return a security error and refuse to route to the back-end server.

Figure 63. Routing Rules

Configuring server farm properties for Application Request Routing

After the server farm has been created and defined, you need to set additional properties to manage the behavior of ARR.

1. Log in to the ARR Proxy Server and launch the IIS Server Manager.
2. Select the Server Farm you created. The following options are displayed on the right-hand pane:
   - Caching
   - Health Test
   - Load Balance
   - Monitoring and Management
   - Proxy
   - Routing Rules
   - Server Affinity
3. Select Caching.
   a. De-select the Enable disk cache option to disable caching.
   b. Set the Memory cache duration to 0.
4. Select Health Test.
   a. Enter the fully qualified domain name (FQDN) of the ARR proxy server in the URL field. The value should be: https://<Proxy IP|FQDN>/hapi/ping. This is the URL, which ARR uses to send requests to the WDM Management Server to check the Health for a particular server farm.
   b. Set the Interval time period after which the ARR Health Test repeats the Health Check. The default is 30 seconds. You can set it to 180 seconds.
   c. Set the time out period of the URL you specified. This is the time period during which if the server does not respond, it is marked as Unhealthy.
d Set the **Acceptable Status codes** to **200–399**. If the Hhealth URL returns a status code that does not match with the value in the **Acceptable Status Codes**, then ARR marks that server as unhealthy.

e Set the text value **Server Healthy** in the **Response Match** field. The text in **Response Match** is verified against the response entity from each server and if response from server does not contain the string specified in response match then that server is marked as unhealthy.

f Click **Verify URL**. This should pass for all the WDM Management Servers in the server farm.

5 **Change the Load Balance algorithm.**
   a Select **Server variable hash** from the **Load balance algorithm** drop-down list.
   b Enter the **Server Variable** value **HTTP_WDM_X_USER**.
   c Click **Apply**.

6 **Double click the Monitoring and Management option** to view the WDM Management Server health status and other statistics. You can set the status to Healthy manually.

7 **Double click Proxy** to configure the proxy settings:
   a Change the **Response buffer threshold** value to 0.
   b De-select the **Keep Alive** option.
   c Change the **HTTP** version to **HTTP/1.1**.
   d Select the **Reverse rewrite host in response headers** option.

8 **Double click Routing Rules.**
   a Click **URL Rewrite** on the **Actions** pane.
   b In the **Edit Inbound Rule** page, set the **Pattern** to `(webui|hapi)/.*`.

This step ensures that the ARR Proxy Server forwards only the URL requests meant for the WDM Management Server to the Server Farm.

The Server Farm properties are now configured.

## Logging to the web UI browser

1 Log in to the WebUI using the proxy IP or FQDN in the browser URL.

2 When the logged in server becomes Unhealthy based on the above Health test, then the web UI logs out.

---

### Monitoring and Management

Use this feature to view the runtime statistics of Application Request Routing. Use Actions to manage the content servers.

<table>
<thead>
<tr>
<th>Group by:</th>
<th>No Grouping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Available</td>
</tr>
<tr>
<td>10.150.101.6</td>
<td>Available</td>
</tr>
<tr>
<td>10.150.109.105</td>
<td>Available</td>
</tr>
</tbody>
</table>

---

**Figure 64. Monitoring and Management**

3 Log in again to connect to the other healthy backend server.
This section contains database scripts supported by Wyse Device Manager (WDM) and related functionality details.

Topics:
- Requirements
- Proposed way of installing WDM database
- Script files

**Requirements**

**Existing WDM database support**

WDM installation supports SQL Server 2008. The database contains all the SQL server objects such as tables, views, stored procedures, and so on. The WDM installer stores the database to the respective folder (default is: `C:\Program Files (x86)\Wyse\WDM\Database`) and attaches the same to server machine where WDM needs to be install.

Then the installer updates the server details, user details, Software Repository configuration details, and so on to the server machine.

**Proposed way of installing WDM database**

The scripts are used to install WDM database version 5.7.3.

Prerequisites—Before executing the scripts, the database path folder must be created and firewall must be disabled in the database server.

NOTE: The following scripts must be executed in the same order as they are mentioned. If not, you have to delete the database and repeat the entire process again.

**Script files**

The following database script files will be used to install database of WDM 5.7.3:

- CreateDatabase.sql
- Schema&User.sql
- Tables.sql
- Userdefinedtables.sql
- Views.sql
- Stored_Procedures.sql
- Default_Table_Data.sql
- CustomizeScript.sql

**CreateDatabase.sql**

To create the database manually, execute the following script:
The database scripts are mentioned here for customization purpose.

CREATE DATABASE [RapportDB]

ON PRIMARY
(NAME = N'Rapport_dat', FILENAME = N'C:\Program Files (x86)\Wyse\WDM\Database\Rapport4.MDF,
SIZE = 42496KB, MAXSIZE = UNLIMITED, FILEGROWTH = 10%)

LOG ON
(NAME = N'Rapport_log', FILENAME = N'C:\Program Files (x86)\Wyse\WDM\Database\Rapport4.LDF',
SIZE = 768KB, MAXSIZE = UNLIMITED, FILEGROWTH = 10%)

GO

1. The script file contains RapportDB Database creating scripts.
2. User or Administrator can change the file path. Default file path is C:\Program Files (x86)\Wyse\WDM\Database.

**NOTE:** Check the above mentioned folder to verify the step. This folder should contain Rapport4.mdf and Rapport4.ldf.

**Schema&User.sql**

To create a user account execute the script. You can add and assign permission to any user account.

1. The script file contains the details about creating schema and User role.
2. The default values are rapport schema and rapport user. If you want to change the WDM access user, you can change from here.

**Tables.sql**

This script file contains script for all table objects and constraints.

**NOTE:** Custom changes are not included in this file.

**Userdefinedtables.sql**

This script file contains script for all the User Defined Table objects.

**NOTE:** Custom changes are not included in this file.

**Views.sql**

This script file contains script for all View objects.

**NOTE:** Custom changes are not included in this file.

**Stored_Procedures.sql**

This script file contains script for all Stored Procedure objects.

**NOTE:** Custom changes are not included in this file.

**Default_Table_Data.sql**

This script file contains script for all Default Table Data values such as, OS, Platform, Management Type, Default Groups, Default Software Packages, Default Parm details, and so on.

**NOTE:** Custom changes are not included in this file.

**CustomizeScript.sql**

This script file contains script for Customize Data values.

Provide the database server name while executing the following script. An error is displayed, if you do not enter the server name.
Use RapportDB
Go
SET IDENTITY_INSERT [dbo].[License] ON
INSERT [dbo].[License]
([LicenseID], [Sales], [UnActivated], [Code], [License], [Utilize], [NumberOfClients],
[VendorID])
VALUES
(1, N'7V931PHY08K01L2HYXWKKP6GQ1', N'BR69T51SSP500PFW9W4R0Z0TL5', NULL, NULL, NULL, NULL, NULL)
SET IDENTITY_INSERT [dbo].[License] OFF
GO
SET IDENTITY_INSERT [dbo].[sysHash] ON
INSERT [dbo].[sysHash] (ID, Hash) VALUES (2, 0x4458473935334D3151303452524643383442485836)
SET IDENTITY_INSERT [dbo].[sysHash] OFF
Go
Begin
Declare @DBServerName varchar(200) = ''
Set @DBServerName = ''
If (@DBServerName is null or @DBServerName = '')
Begin
RAISERROR(N'Database Server Name Should not be Empty...', 16, 1)
End
Else
Begin
SET IDENTITY_INSERT [dbo].[Install] ON
INSERT [dbo].[Install]
([InstallID], [Module], [ServerName], [UserName], [Installed], [Status], [Information],
[RegKey], [RegName], [RegValue], [LatestHFID], [SiteID], [SiteName])
VALUES
(0, N'Rapport4DB', @DBServerName, N'administrator', GetDate(), N'MASTER', NULL, NULL, NULL, NULL, N'00HF05070001516', 0, NULL)
SET IDENTITY_INSERT [dbo].[Install] OFF
End
Go
This section describes how to troubleshoot the issues that you may encounter while installing or upgrading WDM.

Topics:
- Failure While Attaching the Database
- Error While Installing WDM Database in a Distributed Setup
- Database Installation Failure After Manual Uninstallation of SQL Server Express 2014
- After Upgrading from WDM 5.5.1 to WDM 5.7 Software Repository is not Secure
- Troubleshooting Post Deployment
- Troubleshooting Load Balancing Issues
- Cloud Environment Setup Issue
- Error in Installation of WDM in Upgrade Setup


**Issue:** .NET Framework 3.5 installation fails on Windows Server 2012 and Windows server 2016 with error code 0x800F0906

**Resolution:**

**Method 1:**
1. Log in to the system where you have installed Windows Server 2012 and Windows server 2016, and launch the Server Manager.
2. Install .NET Framework 3.5 features using the Add Roles and Features wizard in Server Manager.
3. While installing specify an alternate source path using the link at the bottom of the wizard.

**Method 2:**
Using DISM from the command prompt, specify the source files path parameter:

For example, if D: is the Windows Server DVD media, the source files path would be: DISM /Online /Enable-Feature / FeatureName:NetFx3ServerFeatures /FeatureName:NetFx3 /Source:D:\Sources\sxs

**Method 3:**
1. Log in to the system where you have installed Windows Server 2012 and Windows server 2016, and launch the Server Manager.
2. Install Server Role Windows Server Update Services (WSUS) using Add Roles and Features Wizard in Server Manager.
3. Using DISM from the command prompt, specify the source files path parameter: DISM /Online /Enable-Feature / FeatureName:NetFx3ServerFeatures /FeatureName:NetFx3
4. Make sure Windows Update Service is running, and Windows Update store can be connected from where the necessary components can be retrieved.
Failure While Attaching the Database

Issue: Failure while attaching the database on Windows 2012 Server, with SQL Server 2012.

Resolution:
Run SQL Service ‘MSSQLSERVER’ using the ‘LocalSystem’ account on the system where WDM installation is targeted.
Retry WDM installation.

Error While Installing WDM Database in a Distributed Setup

Issue: When you are installing the WDM Database on a separate system that has the supported version of SQL Server installed on it, then the following error may be displayed when you launch the Setup.exe: Setup was unable to initialize the required libraries.

Resolution: Make sure that the Microsoft Visual C++ Redistributable 2008, version 9.0.21022 is installed. You need to navigate to Start > Control Panel > Programs to view if the redistributable is installed. If it is not installed, then you must manually install it by running the vcredist_x86.exe available under the Prereq folder of the WDM Installer.

Database Installation Failure After Manual Uninstallation of SQL Server Express 2014

Issue: The WDM database installation fails after you manually uninstall the existing SQL Server Express 2014, and use the Install New Database option in the installer.

Resolution: To resolve this issue:
1. Uninstall SQL Server Express 2014 R2 from Add\Remove Programs.
2. Launch the Services window from Control Panel > Administrative Tools.
3. Delete the MSSQL$RapportDb Service
4. Delete MSSQL12.RAPPORTDB from the SQL Server Express Installation folder.
5. Delete the RapportDB registry entry from HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL Server\Instance Names\SQL.
6. Delete the MSSQL10_50.RAPPORTDB registry entry from HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL Server.
7. Delete the RAPPORTDB registry entry from HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL Server.
8. Restart the WDM Installer.

After Upgrading from WDM 5.5.1 to WDM 5.7 Software Repository is not Secure

Issue: If WEB UI is selected during Upgrade, then Management server will be configured to Https, But WDM Software repository will not be configured by the installer.

Resolution: Manually Set the Software repository to HTTPs in the WDM GUI. To set manually, go to Configuration Manager Software Repository.
Troubleshooting Post Deployment

**Issue**: HTTP Error 404.0 – Not Found. the Web.config of the HApi shall be added with a url routing module if it’s missing:

**Resolution**: Add the Web.config of the HApi with a URL routing module as follows:

```xml
<system.webserver>
  <modules>
    <remove name= "urlroutingmodule-4.0"/>
    <add name= "urlroutingmodule-4.0" type="system.web.Routing.urlroutingmodule" precondition="" />
  </modules>
</system.webserver>
```

Troubleshooting Load Balancing Issues

This section describes how to troubleshoot some issues that you may encounter in the Load Balancing setup.

**Health test feature failure in ARR proxy with SSL**

**Issue**: If the ARR Proxy does not trust the backend server’s Digital Certificate, the health test may fail with the Error Code 80072F8F.

**Resolution**: Import the certificate that is used to setup SSL on the WDM management server onto the Trusted Root Certificate Authorities store for a local computer on the ARR Proxy system by referring to [technet.microsoft.com](http://technet.microsoft.com).

ARR Proxy Returns HTTP Error Code 502.3

**Issue**: The ARR Proxy returns the HTTP Error Code 502.3 for older WDM Agents (HAgents) that do not send the `HTTPHEADSUPP=2` tag when they are checking in. If the HAgent does not send the `HTTPHEADSUPP=2` tag while checking in, then the Management Server does not send the HTTP status code header (200 OK) in response and the ARR proxy returns the error. Only the clients sending the value 2 are supported in load balancer setup.

**Resolution**: You can run the following query on the WDM Database and read the value:

```sql
SELECT [HttpHeadSupp]
FROM   [ClientNetwork]
where  [MAC] = <ClientMac>
```
ARR Proxy Returns HTTP Error Code 502.4

**Issue:** The ARR Proxy server could return the HTTP Error Code 502.4 when any of the Management Servers (H Servers) are not available. The Health Status of all the H Servers in the **Server Farm** may be set to **Unhealthy** because the configured Health Tests have failed.

**Resolution:** To correct this:
1. Log in to the ARR Proxy Server and launch the IIS Server Manager.
2. Select the Server Farm you created and on the right-hand pane, select **Monitoring and Management**.
3. Select the H Servers and in the **Action** pane, select **Set Server as Healthy**.
4. If the load on the H Server is high then try to increase the **interval** and **time-out** values in the **Health Test** feature.

Enabling SSL Offloading on Proxy

Load Balancing is only supported in HTTPS setup. For debugging, if you want to see the Management Server (H Server) response in **Wireshark** capture, then you can change the H Server-Proxy communication to HTTP.

1. Log in to the ARR Proxy Server and launch the IIS Manager.
2. Double click the **Routing Rules** feature and select **Enable SSL offloading** setting.
3. Enable both HTTP and HTTPS binding in the website on the H Server machines and do not select **Require SSL** in the **SSL Settings**.

Indefinite Preceding during Installation

**Issue:** Installation proceeds indefinitely while installing Microsoft Visual C++ Redistributables or Microsoft SQL Express 2008. The OS Supported are Windows 2012 Standard and Windows 2012 R2.

**Resolution:** Open the Task Manager, and check whether the ‘**Windows Modules Installer Worker**’ process is running on your thin client or not. If this process is running, you must end the process for installation to resume. Restart the thin-client after the installation is complete.

Load Balancer Issue

**Issue:** Proxy Server does not respond if the IP V6 Address is enabled.

**Resolution:** Disable the IP V6 Address of the Load Balancer Setup.

Upgrading WDM on Windows 2008 SP2 32 bit

**Issue:** To upgrade WDM 5.7 on Windows 2008 SP2 32 bit, enable the Windows Update service.

**Resolution:** To upgrade WDM 5.7 on Windows 2008 SP2 32 bit, enable the Windows Update service to install the Hotfix KB980368. After the installation of Hotfix KB980368, disable the Windows Update Service to install the WDM 5.7.

WDM Upgrade Installation Fails

**Problem:** WDM Upgrade installation fails while connecting to software repository.
**Resolution:** One of the reasons for this issue is, the Computername for the setup has more than 16 characters. This brings out a mismatch in Computername and NetBIOS name (truncated to 15 chars) for the setup. To confirm this issue, check if the above mentioned system variables are different. If yes, install WDM on a setup which has hostname to a max of 15 characters, and then re-run upgrade installer.

**Cloud Environment Setup Issue**

**Issue:** An error message is displayed intermittently when you run the setup.exe file during WDM installation in the cloud environment.

**Resolution**

- **Scenario 1– Only the error message is displayed**
  
  Close the dialog box displaying the error message, and then run the setup.exe file again.

- **Scenario 2– An error message is displayed along with the Welcome Screen running in background**
  
  Close the dialog box displaying the error message and the Welcome screen, and then run the setup.exe file again.

**Error in Installation of WDM in Upgrade Setup**

**Issue:** During the installation of WDM, if you use different database user other than the default user, then you will not be able to proceed with the installation of WDM in Upgrade setup. **Unable to proceed with the installation, aborting installation** error message is displayed.

**Solution:**

- Open WDM GUI.
- Right click Configuration Manager and select Utilities > Database Credential Manager.
- A warning message is displayed. Click OK.
- Enter the user name and password of the user used when you installed WDM. Click Ok to continue.
- Now close the WDM GUI and proceed with the installation.
- After installation, run the Database Credential Manager available in the Install path (C:\Program Files(X86)\Wyse\WDM \Utilities\Database) again.
- Provide your username and password used when you installed WDM, and then reboot the server.